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RAW Image Processing, Viewing and Editing Software
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Ver. 3.8

Instruction Manual

Content of this Instruction Manual

DPP is used for Digital Photo Professional.

In this manual, the windows used in the
examples are from Mac OS X 10.4.

» indicates the selection procedure of the menu.

Example: [Digital Photo Professional] menu »
[Quit Digital Photo Professional].

Square brackets are used to indicate items such
as menu names, button names and window
names that appear on the computer screen.

Text inside < > indicates a key on the keyboard.

** indicates a reference page.
Click to move to the relevant page.

"2 : Marks helpful information when a problem
arises.

0k

@ : Marks information that should be read

N1/
s

before use.

Marks additional information you may find
helpful.

Marks tips for using the software skillfully.

Switching Between Pages

Click on arrows on the bottom right of the screen.

@ : next page

() : previous page

@ : return to a page you had previously
displayed

Click on the chapter headings on the right side
of the screen to switch to the contents page of
that chapter. Also, click the item you want to
read about on the table of contents to move to
the relevant page.

Help and Shortcut Keys

For information about using DPP, refer to Help
from the [Help] menu.

Refer to the “Shortcut Key List” in the Help for a
list of shortcut keys which are helpful for quick
operation.
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Introduction

Digital Photo Professional (hereinafter, “DPP”) is a high-performance
RAW image processing, viewing and editing software for EOS DIGITAL
cameras. It is often thought that RAW images are difficult to handle
compared with ordinary JPEG images, but using DPP, you can perform
advanced edits and print RAW images with ease.

RAW Images and Their Features
What is a RAW Image?

A RAW image is image data that has recorded output data of imaging
sensor. Because image processing does not occur inside the camera
when a photo is taken and the photo has been recorded in the special
form of “RAW image data + Image processing conditions information at
the time of shooting”, special software is needed to view or edit the
image.

* “RAW” means “in a natural condition” or “not processed or refined”.

What is RAW Development?

If described in terms of film, the concept of a RAW image is a shot
image not yet developed (latent image).

With film, the image appears for the first time when it is developed. And
as for RAW images too, you cannot view it as an image on your
computer unless you perform subsequent image signal processing.
Therefore, even though it is digital, this processing is called
“development” and with EOS DIGITAL is performed using DPP.

With DPP, you can view, edit and print RAW images without having to be
particularly conscious of the development processing.

What Advantages Does a RAW Image Have?

RAW images are recorded in the format “RAW image data + Image
processing conditions information at the time of shooting”. When you
open an image in DPP, the image is instantly developed and you can
view the image as an image to which image processing conditions at the
time of shooting have been applied.

Even if you perform various adjustments to the image you have opened
(it undergoes automatic development processing each time), only the
image processing conditions (development conditions) change and the
“original image data itself” remains unaffected. Consequently, image
deterioration is not a problem and it is the perfect image data for users
who want to get creative with their images after they have been shot.

In DPP, the “Image processing conditions information” that can be
adjusted is called a “Recipe”.

Image processing conditions information
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Main Features of DPP

Following are the main tasks you can perform with images you have
downloaded to your computer.

View and organize RAW images
Real-time adjustment of a RAW image

Various image adjustments while maintaining the original image
Freely apply a Picture Style
View your image before and after adjustment in the same window

:I'rimming and adjusting the angle of an
image

Change image size

Correction of lens aberration
Automatic/manual dust erasure processing

Convert from a RAW image to a JPEG or

TIFF image and save
Process large numbers of RAW images in batches
Transfer the image to image editing software

Print a RAW image
View and organize JPEG and TIFF images

Real-time adjustment of JPEG and TIFF
images
Various image adjustments while maintaining the original image

Print JPEG and TIFF images

Color management compatibility
CMYK simulation for commercial printing

System Requirements

(0153 Mac OS X 10.4 to 10.6

Computer | Macintosh with one of the above OS installed
CPU* PowerPC G4, G5 or Intel processor

RAM Minimum 1GB

Display Resolution : 1024 x 768 or more

Colors : Thousands or more

* Core2 Duo or higher is recommended

This software program is not compatible with UFS (UNIX File System)
formatted disks.

Supported Images

This software supports the following image types.

Image type Extension
RAW images*! shot with EOS DIGITAL
cameras, excluding EOS DCS1 and .CR2
RAW images | EOS DCS3 .TIF
RAW images*? shot with PowerShot .CRW
cameras
JPEG images | Exif 2.2 or 2.21-compatible JPEG images| .JPG, .JPEG
TIFF images | Exif-compatible TIFF images .TIF, .TIFF

*1

*2

Compatible with RAW images shot with EOS D6000 or EOS D2000
that have been converted to RAW images using the CR2 Converter
and have the “.CR2” extension.

For information on CR2 Converter, refer to Canon’s web site.

» Only models where Digital Photo Professional is listed in the “Data
Type” item in the “Specifications” section near the end of the
Camera User Guide.

* Use the dedicated CameraWindow application to download images
from a PowerShot camera to a computer. See the Software Starter
Guide for details.

* Lens aberration correction can only be used with some camera and
lens models.

* Automatic dust erasure processing and other EOS DIGITAL specific
functions cannot be used.
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Introduction

Downloading Images to Your Computer Erase dust shot with the image - p.64, p.66
Download images by connecting your cameraand ~ _, 0.7 Erase unwanted parts of an image - p.63 Contents at
computer ' Auto correct RAW images with the Auto Lighting Optimizer =» p.58 a Glance
Download images using a card reader =p9 Adijust brightness of shadows/highlights - p.54
— . Reduce image noise - p.59 Basic
Viewing and Checking RAW Images Correct lens aberration =» p.60 ok
Quickly enlarge parts of an image = p.11 Use a Picture Style file - p.56
Sort images (check marks) - p.17, p.18 Edit efficiently - p.31 Advanced
. . . . Operation
Display an image shot simultaneously as a RAW - p.20 Edit an image while comparing the image before and
image and JPEG image as a single image ‘ after adjustment = p.50
Display the images in the thumbnail list display at high Svnchronize multiple imaaes =051 Advanced
resolution = p.21 DY I bp g tﬁ t _ P- Imac?tle,lgdtiging
isplay an area beyond the set range as a warnin and Printin
Check shooting information such as the shooting date =» p.10, p.21 indiF():at)c;r (Highlight/yShadow warning) 9 osps2 J
. . . Restore an adjusted image to its condition at the time  _, Processing
Editing RAW Images (Adjusting) of shooting : e
Adjust brightness/darkness ->p.12,p.24 Lo —
Use automatic adjustment = p.30 Printing Editing
Change the Picture Style = p.24 Print well on a Canon printer =» p.40, p.71, p.72 JITEG/TIFF
Sharpen the modulation and contrast of colors . . mages
- p.27 Faithfully reproduce the color of the subject -~
(contrast) P when prBi/ntinpg J = p.40, p.71, p.72
Make skln. tone look healthier (.c?Ior tone) ' p.27 Print with the shooting information -> p.69 Reference
Make the image colors more vivid (color saturation) = p.27 Print a thumbnail list of images - p.70
:/I;ke an @age stharp f(shar;l)ness) wral *p29 Approximate the color seen on screen with your =077
just an image to make color tone more natura rinting results -
(white balance) 2 p25 P J Index
Change an image to black-and-white or sepia tones Conversion of Images S
(monochrome) = p.28
) ) . i Convert a RAW image to a JPEG image - p.39, p.83
Trim an image and adjust the angle of an image = p.35 "
i i i Edit in Photoshop = p.68, p.84
Specify an aspect ratio that matches the size of the 2035 .
paper on which an image is to be printed P Perform batch processing = p.83 @“
Edit (adjust) a JPEG image =» p.87 m—




1 Basic Operation

The basic operational flow — from how to download to your computer
images shot with a camera to checking, editing, saving and printing a
downloaded RAW image — is explained here.

)
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Starting up DPP

Click the Dock icon.

Digit_i;l Photo Profe ssiq_l_'lal

Click

DPP starts up and the main window ([Folder] window) appears.

v

Main window ([Folder] window)

o

Main Window Display

In the main window, you can use tabs to select either the [Folder]
window or the [Collection] window. The [Folder] window displays the
images in folders on your computer, while the [Collection] window (p.33)
displays images selected randomly by the user from one or more folders
and gathered together.

Unless noted otherwise, the [Folder] window will be described as the
main window from this point on.

[Folder] window

& Digital Photo Professi
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Downloading an Image to Your Computer

Connect the camera and computer with the cable provided and
download the images saved on the memory card inserted in the camera.
For downloading images, start up the camera software “EOS Utility”

from DPP and use.

Select the save destination for the images.
Select the save destination in the folder area on the left of the

main window.

When creating a folder, refer to p.47.

8086

T3]

Folder

Collection(0)

v =} MacOosx
b | & Applications
|7 Temporary Items
¥ [ B Users
v i canon
- [@F Dasktop
- |1 Documents
» [ Library
= Movies
|4 Music

b [ Shared

Digital Photo Profe

Start up EOS Utility.
Select the [Tools] menu » [Start EOS Utility].

Tno!s
sStart EO5 I.Jtili'f'l_.nr NHEE

Transfer to Photoshop o5 P
Start Quick check tool HF
Start Trimming/Angle Adjustment too EET
S5tart Stamp too W3S
Start Rename too CRER

EOS Utility starts up.
EOS Utility

8enNnn EOS Utility

Control Camera Accessories

Starts to download images

Lets you select and download images

Camera settings/Remote shooting

“ Monitor Folder
ey
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Connect your camera and computer and turn the
camera on.
Connect the camera and your computer with the interface cable
provided with the camera and turn the camera on.
For detailed instructions on connecting your camera and
computer, refer to the “EOS Ultility Instruction Manual” (PDF
electronic manual).

Accessories

@ Starts to download images
4

'ﬁl Lets you select and download images
e

E Camera settings /Remote shooting
’ Monitor Folder
7]

Downloading of images begins.

The downloaded images are saved in the folder selected in step
1 and are displayed in the main window of DPP.

The downloaded images are sorted by date into folders and
saved.

5@/3 Advantages of using EOS Utility to download images

Using EOS Utility to download images makes it easier to organize your
images as they are downloaded, sorted and saved into folders by date.

5

You cannot start up EOS Utility in the [Collection] window
(p.6, p.33).
When EOS Utility has been started up from DPP, you cannot use
the following functions.
* Quick check window view (p.16)
* Trimming and adjusting the angle of an image (p.35, p.95)
* Dust erasure processing (copy stamp function)
(p.64 to p.68, p.98 to p.102)
 Batch change file names (rename function) (p.85)
* Printing with shooting information (p.69)
* Printing a thumbnail list (contact sheet printing) (p.70)
* Printing using Easy-PhotoPrint EX or Easy-PhotoPrint
(Plug-in printing) (p.40, p.43)
* Transferring images to Photoshop (p.68)
* Batch saving images (batch processing) (p.83)
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Downloading Images Using Your Card Reader

You can also download images to the computer using a third-party card
reader.

Load the memory card into the card reader.

Open a removable disk icon in the folder area and
move the [DCIM] folder inside to a suitable place
such as to the [Desktop].

806 Digital Photo Profi

Folder Collection(0)

» | & Library

= Movies

& Music
» |2 Pictures
P (& Public

b | Sites

» [ Shared

v | EOS_DIGITAL
» [ DCIM

The [DCIM] folder is downloaded to your computer.
All images are saved in folder units inside the [DCIM] folder.

Display the images downloaded to your computer.
In the [DCIM] folder copied to your desktop, select the folder
where the shot images are saved.

Digital Photo Professional

b A Applications
|.= Temporary Items
¥ & Users
v @ canon

[ 100CANON
(7 102cANON
» |7 Documents

» | & Library
= Movies

& Music
» |2l Pictures

Images in the folder are displayed in the main window of DPP.

Y
N

== Checking before downloading images

By selecting the memory card folder directly in DPP, the images in the

folder are displayed in DPP and you can check the shot images.

@ In a Mac OS X 10.6 environment, you cannot move files or folders in

the folder area.

5

Copying to your computer may take time when there is a large
number of shot images saved in the memory card.

For details on the [DCIM] folder structure and the file names of
shot images, refer to “Folder Structure and File Names in the
Memory Card” in the “EOS Utility Instruction Manual” (PDF
electronic manual).
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Viewing an Image

Images downloaded to your computer are displayed as a thumbnails list
in the main window. You can double-click an image to open the edit
window and display the image at large size.

View Images as Thumbnails in the Main Window

o Rotate selected image
Main window ‘

uuuuuu

(((((((((((((

Click to select the image

Display thumbnails of all the images inside the
folder selected in the folder area on the left

® Images displayed with the ["®] icon are movie files and cannot be
played back in DPP. Please use “ImageBrowser”, which is
compatible with EOS DIGITAL movie files.

|§| When aspect ratio information is attached to the shot image with
the EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark Ill or EOS
7D, the image is displayed as a trimmed image (p.35, p.95).
For a list of main window functions, refer to p.107.

Changing the Size of Thumbnail Images

You can change the size of the thumbnail images displayed in the main
window and display them with shooting information attached.

Select the [View] menu » desired item.

View
Edit in Edit image window *—
View collections NHC

+ Tab

v Folder view

v Toolbar
Tool palette ®T
Large thumbnail #1

v Medium thumbnail #2
Small thumbnail ®3
Thumbnail with information 34
Sort »

The display changes to the selected item.
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Enlarge and View an Image in the Edit Window

Double-click

st st 5 am 7

The edit window appears.

Edit window '

800 [* Digital Photo Professional - [ MacOSX /Users /canon/Pictures [ Photo /3000¢_xx_xx/IMG_0001.CR2 |

Tool palette

RAW / Adobe RGE CMYK 7

(1374, 573):244, 245, 244 High guality

It may take time for the image to redraw itself.
Click the [®] in the upper left of the edit window to close the edit
window.

@ By selecting the [View] menu » [AF Point] in the edit window, you can
display the AF points selected in the camera at the time of shooting.
However, AF points are not displayed for images which have had their

image size changed and then been converted and saved (p.39, p.116).

For a list of edit window functions, refer to p.110.

Enlarging and Viewing a Specific Area

Double-click the area you want to enlarge.

© OO [ Digital Photo Professional - [ MacOSX/Users/canon/ Pictures/ Photo/ xxxx_xx_x/IMG_0001.CR2 |

e & Double-click

RAW / Adobe RGB CMYK /7,

The area you double-clicked is enlarged to 100% (actual pixel
size). If you wait for a while, it changes to a clearer display.
Double-click again to revert to the full view.

To change the display position, drag on the image or drag the
enlargement display position of the tool palette.

Tool palette enlargement display position

Change the enlargement
display position by
dragging

To display an image in an enlargement ratio other than 100%

Select the [View] menu » [200% view] or [50% view].

|§| You can change the enlargement ratio when you double-click (p.75).
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Adjusting an Image

You can perform a variety of image adjustments, such as adjusting the
brightness or changing the Picture Style of an image using the tool
palette of the edit window. You can easily restore an image to its original
settings with the [ % ]] button even if you have made the wrong
adjustment. Try out the various adjustments.

As an example, the procedure to adjust the brightness of an image is
explained here.

Tool palette
[ RAW | RCB  NR/Lens/ALO
r samem—, | .
|Erightness adjustment l =] | Reverts the |mage tO
=) v the original settings
|While balance adjustment -~ | I:_)rag the S“der Ieft or
— right
‘_f r
Shot settings | :J f Tune...
Picture Style ]
Standard -:J ’ Browse... |
-10.0 -8.0 -6.0 -4.0 =-2.0 1] 20 4.0
Contrast: =
Highlight: : : =
Shadow: T
| Linear
Colaor tone: -
ic) o
Color saturation: ¥
] i
Sharpness: '—i\_—/‘r'—'

The image brightness changes in real time according to the
amount of adjustments.

? The tool palette does not display
Select the [View] menu » [Tool palette].

About the Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens/ALOQ] tab sheets according to your editing
requirements.

Because adjustment made with the tool palette (it undergoes automatic
development processing each time) only changes the image processing
conditions, the “original image data itself” remains unaffected.
Therefore, there are no problems with image deterioration that arise with
editing and you can readjust your images any number of times.

See Chapter 2 onwards for more detailed information on the various
functions of the tool palette.

About Recipes

In DPP, all the adjustment contents (image processing conditions
information) made with the tool palette is saved to an image as data
called a “Recipe” (p.80).

@ For a list of tool palette functions, referto p.111.
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Saving an Image

If you perform the save operation described here, you can save all the
adjustment contents (recipe) made with the tool palette to the RAW
image.

Select the [File] menu » [Save].

Close window HW
[ save %S
Save As... i #S5
Convert and save... ®D
Page setup... {r 3P
Print... 3P
Print with detailed setting... 3D
Contact Sheet Prints... ~ 3P
Plug-in printing >
Info... |

Your adjustment contents (recipe) are saved to the image.

Saving

With DPP, you can perform the following types of saving according to
your requirements. For detailed information on each saving method,
refer to Chapter 2 onwards.

Save (p.38)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save.

Save as (p.38)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save as a separate RAW image. The original RAW image
remains unaffected.

Add thumbnail to image and save* (p.21)

Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images
redraw themselves more quickly.

Convert and save (p.39)

Convert adjusted RAW image to a JPEG or TIFF image and save.
The original RAW image remains unaffected.

Batch process (p.83)

Convert in batches adjusted multiple RAW images to JPEG or TIFF
images and save.

The original RAW images remain unaffected.

* Option available in the main window.
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Printing an Image

You can print images with a printer. As an example, the procedure to
print one image on one sheet of paper is described here.

Select the [File] menu » [Print].

Close window HW
Save #S5
Save As... i35
Convert and save... #D
Page sefup... it 3P
[ Prine.. %P )
Print with detailed setting... 4 3#D
Contact Sheet Prints... ~ 3P
Plug-in printing >
Info... |

The [Print] dialog box appears.

Print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [Print] button.
Printing begins.

-Z\@/E To change the paper size

To set the paper size etc., select the [File] menu » [Page setup].

Printing
With DPP, you can perform the following types of printing according to
your requirements. For detailed information on each printing method,
refer to Chapter 2 onwards.

Print one image (p.46)

Print using a Canon inkjet printer (p.40, p.43)

Print with a high-end Canon printer (p.71)

Print with shooting information (p.69)

Printing a thumbnail list (contact sheet printing) (p.70)

Quitting DPP

In the main window, select the [Digital Photo
Professional] menu » [Quit Digital Photo

Professional].

Digital Photo Professional

About Digital Photo Professianal
Preferences...
Services

Hide Digital Photo Professional

Hide Others #H

[ Quit Digital Photo Professional

DPP quits.

@ A confirmation dialog box for saving the images appears when you
try to quit DPP without saving the adjusted image. Click the [Yes to
all] button to save the adjustment contents (recipe) to all the images

adjusted.
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D Advanced Operation

A more advanced operation — from efficiently checking images, to
various ways of editing an image, printing a RAW image using a Canon
printer and sorting images — is explained here.

Efficiently Checking/Sorting Images.........cccc...oc....... 16
Sorting IMages........ooeiiiiiiieeeceeeee e 17
Sorting Images in the Main Window ...................... 18
Arranging Images in the Main Window...................... 18
Arranging by TYPE .....uuuieiiiiiieeeeeeeeeeeeeeeeee e 18
Arranging Freely ..., 19
Displaying a RAW Image and JPEG Image as a Single
0 4 F= o [ 20
Improving the Quality of an Image in the Main Window ... 21
Checking Image Information................................ 21
Editingan Image ..., 23
About the RAW Tool Palette..........cccoovvveeeeeieeinnnnnns 23
Editing with the Tool Palette in the Main Window.. 23
Adjusting Brightness .........ccccceeiiiiiiiiiiieeeee 24
Changing a Picture Style .........cccc.ccccooveeiiiiiiieeeee. 24
Picture Style File..........coooeiiiiiiiiieeeeeeeeeeeee 25
Adjusting Color Tone by Changing White Balance.... 25
Adjusting Color Tone Using Click White Balance...... 26
Adjusting Contrast ..........ccccciiiiiiiiiiii e 27
Changing Color Tone and Color Saturation............... 27
Adjusting Monochrome..............ccccooeeciiiiieeenneec... 28
Adjusting Sharpness.........cceeeeeeeeeeiieiciiiiiieeeeeeeeeee 29
Automatically Adjusting Brightness and Color (Tone
CUNVE ASSISE) .oeeiiiiiee e 30

Editing Efficiently ..., 31
Editing in the Edit Image Window...............cvvvveeeeee.... 31
Changing the Thumbnail Display Position to a Horizontal
POSItION.......eeiiieee e 33
Gathering and Editing Images in the Collection Window ... 33

Trimming and Adjusting the Angle of an Image....... 35

Applying Adjustment Contents to Other Images...... 38

Saving Editing Results............ccccceeiiiiiiiii . 38
Saving Editing Contents to a RAW Image................... 38
Saving as a JPEG or TIFF Image.........ccccceveeeeeeennnnne. 39

Re-Editingan Image........c.ccoooiiiiiii i 40

Printing an Image ... 40
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint EX......................... 40
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint...........c..cccccceeeennn. 43
Printing Photographs with a Printer other than Canon
Inkjet Printers.........oooo e 46

Organizing IMages .......ccceevveeieieeeeeeeeceee e 46
Deleting an Unwanted Image ..............ccccecvvvvvveeennnn. 46
Creating a Folder for Saving Images.........c.cccccceeen. 47
MOVING IMAQES ...ooviiieeeeeiieeeee e 47
Moving Images in Folders .........cccccceeeeiiiiiiiiiiiieene.. 48
Registering Frequent-Use Folders (Bookmark
Registration) .........cccccooiiiiiiiiiiieee 48

Organizing Bookmarks ..........cccccceeeveviicciiiinieeeeeenn. 48
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Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window

and efficiently check each image. You can attach check marks and sort

images into three groups.

Display the quick check window.
Select the [Tools] menu P [Start Quick check tool].

Start EQS Utility MC3EE
Transfer to Photoshop M_3EP

[ Start Quick check tool ‘CE:EF]
Start Trimming/Angle Adjustment tool 3T
Start Stamp tool CHS
Start Rename tool 3R
Sync folder with EOS Utility

The quick check window appears.

Click the [Next] or [Previous] button to switch
between images to be checked.
Quick check window

[# 2/15 IMG_0002.CR2 [3456 x 2304]

50% view Full screen

Check mark
I R EEN

—c—

All the images displayed in the main window can be checked in
the quick check window.

Double-click the area you want to enlarge.

The area you double-clicked is enlarged to 50% view.
To change the display position, drag on the image.
Double-click again to revert to the full view.

To quit, click the [OK] button.

|§| When [AF Point] is checkmarked, you can display the AF points
selected in the camera at the time of shooting. However, AF points
are not displayed for images which have had their image size

changed and then been converted and saved (p.39, p.116).
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> Convenient functions of the quick check window

To check only selected images

You can use the quick check window to check only selected images
by selecting the desired images from those displayed in the main
window and then performing step 1.

Switch between images using the keyboard

You can also switch between images by pressing the <38> + <—>or
<>+ <> keys.

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <g8> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

The enlargement ratio when an image is enlarged is half (50%) of
the 100% (actual pixel size).

You can change the enlargement ratio to 100%, when an image is
enlarged (p.75).

For a list of quick check window functions, refer to p.114.

Sorting Images

You can sort images by attaching three types of check marks for each
subject or theme.

Attach check marks for sorting.
Check mark

%1 2/15 IMG_0002.CR2 [3456 x 2304]

7,

The selected check mark appears in the upper left of the window.

Click the [Clear] button to remove the check marks.
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Sorting Images in the Main Window

You can sort images by attaching three types of check marks in the main
window.

In the main window, select the images you want to
sort and attach a check mark for sorting.

ks /Photo/xxxx_xx_xx ]

Check mark

The selected check mark appears in the upper left of the image
frame.
Click the [Clear check] button to remove the check marks.

ALy

=@> To select multiple images in the main window

Click on desired images while holding down the <3£> key. To select
multiple consecutive images, click on the first image, and then click on
the last image while holding down the <shift> key.

Arranging Images in the Main Window

You can arrange images in the order of the types of check marks you
have attached to images, or in the order of date and time at which the
images were shot. You can also freely arrange images by moving them
individually.

Arranging by Type

Select the [View] menu » [Sort] » desired item.

Edit in Edit image window HE—
View collections NG
v Tab
v Folder view
v Toolbar
Tool palette ®T
Large thumbnail *1
v Medium thumbnail 382
Small thumbnail 33
Thumbnail with information 364

T ) © i< name

Check mark1
Check mark2
Check mark3

Shooting Date/Time

The images are arranged in the order according to the selected
item.
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Sort item
Check mark1 -

Check mark3
Shooting Date/Time

File name

RAW priority

Description

Images with check marks take priority and are
sorted in number order.

Images are sorted by shooting date and time
from the earliest.

Images are sorted by file name in alphanumeric
order (0 to 9 = Ato 2).

Images are sorted in the following order: RAW
images - JPEG images - TIFF images.

-:@/3 Check mark order

When you assign check marks 1 to 3, the images are sorted as follows:

1 selected: 1-2-3
2 selected: 2—1->3
3 selected: 3—2->1

Arranging Freely

Drag and drop the image to the desired location.

@ Digital Photo Professional File Tools Window Help = 4 Wed319oM @
806 - [ o] B

2 i = 2 4

AibeRco/Adebercs  dohquly  Reapeduaves Nomberof mages 15 Number ofseected images'1___can e 7

The image moves to the desired location.

You can also select multiple images (p.18) and move them.

The order of rearranged images is maintained until you quit DPP
or select another folder in the folder area.

Select the [View] menu » [Sort] » [File name] to revert to the
order before the images were rearranged.

-Z@/E Maintaining the order of rearranged images

You can maintain the order of rearranged images even if you quit DPP
or select another folder in the folder area.
Maintain order without changing image file names
You can use the [View settings] tab sheet in the [Preferences] to
maintain the order of images without changing the image file names
(p.75).
Maintain order and change image file names
You can use the rename function to maintain the order of images and
change the image file names all at once in the order they were
rearranged (p.85).
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Displaying a RAW Image and JPEG Image as a Single Image

You can display and handle a RAW image and JPEG image shot
simultaneously as a single image. In particular, you can halve the
number of images displayed in the main window and you can streamline
the checking of a large number of images shot simultaneously.

Select the [Digital Photo Professional] menu »
[Preferences].

Select the [View settings] tab sheet and checkmark
[Display only CR2 images for CR2 and JPEG files of
the same name].

Preferences

General settings l View settings l Tool palette Color management
——

Grid pitch
64 Pixels(8-256)

Locking selected image
E Images opened in Edit window remain selected in main window

Magnification in Edit window

® Fit to window O s0% O 100% O 200%

Magnification when the Edit/Edit image window is double-clicked

™ som O 100% O 200%

‘ E Display only CR2 images for CR2 and JPEG files of the same name )

Sort order in main window
™ Retain sort order

Highlight/shadow warning

Highlight 255 (192-255) [N
Shadow 0 (0-64) _
Quick check tool display
® 50% ) 100% {mairé reduction off)
( Cancel N ( OK )

The main window display updates and the simultaneously shot
RAW image and JPEG image are displayed as a single image
with the [XXD] mark (p.109).

? RAW images with the extension “.CR2” can be displayed as a
single image

Images that can be displayed as a single image are images shot with a
camera that shoots RAW images with the extension “.CR2” and JPEG
images simultaneously. Images that have been simultaneously shot with
a camera that shoots RAW images with the extension “.CRW” or “.TIF”
cannot be displayed as a single image.

—I@/i- When a single image is displayed

Image displayed

The RAW image is displayed in all windows.

Edited image

The content which has been adjusted with any of DPP’s functions (the
tool palette etc.) will be applied to the RAW image only.

However, if you have used the following functions, the adjustments
will be applied to both the RAW image and the JPEG image.

* Deleting an image (p.46)

* Moving or copying an image (p.47)

» Checkmarks (p.17, p.18)

* Rotating an image (p.107, p.114, p.115)

+ Attaching a thumbnail to an image and saving (p.21)

Images added to the [Collection] window

When you add a RAW image and JPEG image displayed as a single
image to the [Collection] window, the single image is marked with the
[X3] mark. However, because the RAW and JPEG images are
actually added individually, the number of images shown on the
[Collection] tab sheet increases by 2 (p.108).

@ In step 2, if you uncheck [Display only CR2 images for CR2 and
JPEG files of the same name], the RAW image and JPEG image
are displayed as separate images.
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Introduction
Improving the Quality of an Image in the Main Window Checking Image Information
Qreate a new thumbnail image for the main window and save to each Select the image for which you want to check the S
'mage. _ o _ , image information. a Glance
The quality of images in the main window improves and images redraw
themselves more quickly. Select the [File] menu » [Info].
] - ] Basic
With all the images selected, select the [File] menu » = Operation
) . pen in Edit window #O
[Add thumbnail to image and save]. Open in Edit window (enlarged)
"I' i-.. I dow 3N Adv ed
Open in Edit window #0 Close window LW Op ion
Open in Edit window (enlarged)
Close all Save S
Open window a6 Save As... {365
Close window g\ Add thumbnail to image and save {r38T ImAa(;‘éaggiet?ng
Convert and save... #D and Printing
Save 35 Batch process... 3B
ye As {138
' Add thumbnail to image and save 3T ] Create new folder... 3N Processing
Convert and save... #D Page setup... 3P Large Numbers
Batch process... #B i 5P of Images
Create new folder... 3N Print with detailed setting... {+3D
Contact Sheet Prints... ~ 3P Editin
Page setup... 0 %P Plug-in printing > JPEG/TIEE
Print... %P : Images
Print with detailed setting... 03D Add to collection G
Contacriheet Prinks ~3¢p Remove from collection 138G
Plug-in printing > Clear collection
Add 1o collection %G Delete .48 GG
Remove from collection 0 %G Info... 2%l ]
The image information window appears (p.22).
=@> The extent of the improvement in quality Index
The quality is improved for any JPEG or TIFF image. While the image —
quality improves regardless of the thumbnail size (p.10), selecting [Large
thumbnail], with its larger display size, shows the improvement more
clearly than [Medium thumbnail] and [Small thumbnail].

@ A large number of images may take some time to add.

You can specify a presetting for JPEG images to improve the

quality of all main window thumbnails (p.73, p.74). o1



Select a tab sheet and check information.
[Shooting Information] tab sheet

[Metadata] tab sheet

& 5 &

[# IMG_0001.CR2

—[ Shooting Information | Metad.

& & & ¥ IMG_0001.CR2

Shooting Information | Metadata ]—

:Item Name

| File Name

| Camera Model

| Firmware

| Shooting Date/Time
| Author

| Copyright Notice

| Shooting Made

| Tv Shutter Speed )
| Av( Aperture Value )
| Metering Mode

| Exposure Compensation
| 150 Speed

| Auteo |50 Speed

| Lens

| Focal Length

| Image Size

| Image Quality

| Flash

| FE lock

| White Balance Mode
| AF Mode

| Picture Style

| Sharpness

| Contrast

| Saturation

| Color tone

| Color Space

| Highlight tone priority
| Auteo Lighting Optimizer

| File Size

| Dust Delete Data

| Drive Mode

| Live View Shooting

| AF Microadjustment
Date (Timel I TO)

| Long exposure noise red...
| High 150 speed noise re...

| Peripheral illumination c...

Value
IMG_0001.CR2
Canon EQ5 XXXX
Firmware Version XXXX
K 0K 00X
Photographer:xXxXX
Copyright: XXX
Program AE

1/40

5.6

Evaluative Metering
1]

3200

OFF

EF-518-55mm f/3.5-5....
55.0mm
MO0

RAW

Off

OFF

Auto

One-Shot AF
Landscape

4

o

V]

1]

sRGB

0:0ff

2:Strong

0:Disable
0:5tandard

Enable

KAXHKKB

No

Low-speed continuous s...
OFF

x

R R

Description

ry
|

)

[Document Title]
XXANKHAX
[Author]

XN
[Author Title]
XXANKHAX

[Description]

XXAHHHAX
[Description Writer]
XXANKHAX
[Keywords]
XXANHHAX

[Copyright Status]
Public domain
[Copyright Notice]
XXANKHAX
[Copyrightinfo URL]
XXANKHAXK

Shooting information is displayed in the [Shooting Information]
tab sheet, while IPTC* information appended to the image in
Photoshop CS3 or later after shooting is displayed in the
[Metadata] tab sheet. IPTC* information provides additional
comments on images, such as captions, credits and the shooting
location. The information is sorted into 5 different categories and
can be viewed by selecting [Description], [IPTC Contact], [IPTC
Image], [IPTC Content] or [IPTC Status] from the list box in the
[Metadata] tab sheet.

* International Press Telecommunications Council (IPTC)

The contents of the [Shooting Information] tab sheet will vary
depending on the camera model.

¥
~
A<

Convenient uses in the main window

Difference with the [Thumbnail with information]

Detailed shooting information for each image is displayed in the
image information window. However, if you want to only check the
main shooting information, you can check it for each image in [View]
menu » [Thumbnail with information] (p.10).
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Editing an Image

This section explains how to adjust an image using the tool palette in the
edit window.

You can easily restore an image to its original condition with the []
button even if you have made the wrong adjustment. Try out the various
adjustments.

How to make adjustments using the [RAW] tool palette functions, and
how to adjust automatically with the [RGB] tool palette are explained in
this section.

Edit window

806 [*! Digital Photo Professional - [ MacOSX /Users fcanon/Pictures /Photo/xxxx_xx_xx/IMG_0001.CR2 |

Tool palette

(1374, 573):244, 245, 244 High guality

RAW / Adobe RGE CMYK 7

The image changes in real time according to adjustments
performed with the tool palette.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <3£> +
<Z> keys.

ﬁl You can rotate an image in the [Adjustment] menu.
You can adjust an image while comparing the image before and
after adjustment (p.50).
You can synchronize multiple images and edit while comparing
them (p.51).
Refer to p.110 for a list of edit window functions, and p.111 for a
list of tool palette functions.

About the RAW Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens/ALOQ] tab sheets according to your editing
requirements.

Adjustments similar to those that can be performed with the functions of
your camera can be performed using the functions of the [RAW] tool
palette. When the camera settings were incorrect during shooting, or
when the shooting result is not what you visualized, you can get closer
to what you envisaged with the [RAW] tool palette which is similar to the
camera.

All functions other than [RGB] tool palette automatic adjustment, and
each function of the [NR/Lens/ALQO] tool palette are explained in
Chapter 3.

Editing with the Tool Palette in the Main Window

By clicking the [Tools] button (p.107) in the toolbar on the main window,
the same tool palette that appears in the edit window is displayed and
you can edit images.
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Introduction
Adjusting Brightness Changing a Picture Style
The brightness of an image can be adjusted. Move the slider to the right If the image you shot is different to what you visualized, you can change
to make the i brighter and to the left to make the i dark i i O G
0 make the image brighter and 1o the left 1o make the image aarker. the Picture Style to get closer to what you envisaged. a Glance
Even if you have saved the image (p.38) with [Monochrome] (p.28)
[ RAW"| RGB | NR/Lens/ALO _ selected, you can still change to another Picture Style at any point by
e s Rever.ts. the image to simply selecting a Picture Style other than [Monochrome]. Basic
[a0n - (2 —the original settings Operation
(- | i
T S 0.1 Enter a numerical
_— i’ tt ) value |Picture Style [ = J-——Reverts the image to
‘ :i i - - - LE__‘!‘ [ Standard -33/ Browse... the Orlgmal SettlngS Adv ed
Ed 1| 2] 3 |CRegister.. = : Select Opeyétion
Shot settings | :] P Tune.—
Advanced
1 Editi
Drag the slider left or right r::g?:rint'i:;g
-10.0 -8.0 -6.0 -4.0 -2.0 [¥] 2.0 l4_{| i
et e Processing
e Large Numbers
T e A of Images
S[E‘nadow: _____ =
s Editing
CDL s = JPEGI/TIFF
i : % Images
Caolor saturation: =Y
i) o
et v Reference
Index
@ Even if the RAW image is from a camera that does not have
Picture Style settings, you can still set a Picture Style as long as @
the RAW image is compatible with DPP (p.3).
ﬁl The adjustment range is —2.0 to +2.0 (in 0.01-stop increments when You can retain the [Color tone], [Color saturation], [Contrast] and
entering a value). [Sharpness] settings, even if you change the Picture Style (p.76).
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Picture Style

Standard

Portrait

Landscape

Neutral

Faithful

Monochrome

(Picture Style file
registered in the
camera)

[Picture Style file
applied in DPP]

Description

The image looks vivid.

Ordinarily, this setting is suitable for most images.

For nice skin tones.

Effective for close-ups of women and children. By
changing the [Color tone], you can adjust the skin
tone (p.27).

For vivid blues and greens.
Effective for making images of landscapes
impressive.

For natural colors and subdued images.
Effective for base images which are to undergo
adjustment.

When the subiject is photographed under a color
temperature of 5200K, the color is adjusted
colorimetrically to match the subject’s color.
Effective for base images which are to undergo
adjustment.

For black and white images.
You can also adjust with [Filter effect] or [Toning
effect] (p.28).

Displayed when selecting an image shot with the
Picture Style file registered in the camera.

In the list, the name of the Picture Style file is
displayed in ().

The name of the Picture Style file applied in DPP
is displayed in [ ].

Picture Style File

A Picture Style file is an extended function file of Picture Style. Refer to
p.56 for how to use Picture Style files.

Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural,
change the white balance to make it appear natural. You can make the
color tone natural by setting the light source at the time of shooting an

image of, for example, pale-colored flowers.

——[“RAWS| RGB | NR/Lens/ALO ——

‘Erighmess adjustment = ;‘
|||-||ll||-!.<2|||-llllll- G"DD

‘White balance adjustment [ o] j}
E | 3 | Register..

[_ Shot settings | :]I Tune )

Select

Reverts the image to
the original settings

? The color tone does not become more natural even when the
white balance is changed

If the color tone of the image does not appear natural after changing the

white balance, adjust the white balance using click white balance (p.26).

=@= Tune with color tone

To make further fine adjustments to color tone after adjusting the white
balance, you can use [Color tone] (p.27) to get closer to your

requirements.

@ You cannot register the adjustment results as personal white
balance (p.82) when you have selected [Shot settings] from the list

box.

@ Refer to your camera’s Instruction Manual for details on each white

balance setting.
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Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

[ RAW | RGE = NR/Lens/ALO
‘Erighmess adjustment = ‘
||||||||||Im||||||||||| G-DD
White balance adjustment =y ‘
7] T3 T Eaguarad _
e s S Click
Shot settings | v] (_ Tune... :I

Click on a point that is to be the standard for white.

000 [¥] Digital Photo ional - [ MacOSX/Users, Cxx_xx/IMG_0010.CR2 | ®O0 v Woolocr
W RGB _NR/Lens/AL

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is

adjusted again.

To finish click white balance, click the [] button again.

Click
The coordinates of the cursor position and the image to the

RGB values (8-bit conversion)

Reverts the

original settings

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

@ The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.
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Adjusting Contrast

Modulation and degree of contrast can be adjusted. Move the slider to
the right to make contrast stronger and to the left to make contrast
weaker.

| Plcture Style [ ® | Reverts the image to
the original settings

Standard & ] ’ Browse... _\'

A

-10.0 -8.0 -6.0 -4.0 -2.0 1] 2.0 .4_0 .
() —Drag the slider left or

Caontrast: =
o— 0 2 right (9 steps)
Highlight: i
] - g
Shadow: r
| Linear

Color tone: L
[ - ;
Caolor saturation:
[

Sharpness: —=
i o

<1

Display the value of the setting

A/

@< [Linear] - A function for advanced adjustment

Use [Linear] when you will be adjusting separately using image editing
software that has advanced editing functions. Note that when [Linear] is
checkmarked, the image will become dim.

|§| The Auto Lighting Optimizer (p.58) will not function when [Linear] is
checkmarked.

Changing Color Tone and Color Saturation

Skin tone and overall color saturation can be adjusted.
If Picture Style (p.24) is set to [Monochrome], [Color tone] and [Color
saturation] switch to [Filter effect] and [Toning effect] (p.28).

‘ Picture Style

( = }— Reverts the image to

Standard

the original settings

i W
I ] | Browse.. |

"10.0 80 -60 -40 -2

L 0 2.0 4.0

Caontrast:
1[0}

Highlight: =r
{0 i
Shadow: -
] B
_| Linear ]
Colai Foriai ’_\‘3' ) Drag the sliders left or
() U right
e o
Caolor saturation: =¥
(0} oJ
Sharpness: =
Display the values of the settings
Color tone: Mainly used for adjusting skin tones. Move the

Color saturation:

slider to the right to make skin tones more
yellow, and to the left to make skin tones
redder.

The overall color depth of the image is
adjusted with color saturation. Move the slider
to the right to make the color deeper, and to
the left to make the color weaker.

@ The adjustment range is —4 to +4 (in 1-stop increments).
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Adjusting Monochrome

When the Picture Style (p.24) is set to [Monochrome], you can create
monochrome photographs with effects similar to filtering and with the
look of a single-color photograph.

Select [Monochrome] in the [Picture Style] list box.

‘F‘icture Styla [ - I}i Reverts the image to
the original settings

, "
Monochrome ! :‘] Browse...

-10.0 -8.0 -6.0 -4.0 -20 0O 20 4.0

Caontrast: L
(0) ! H¥
I[-g]ghlight: P— : =
Shadow: =
() L o
| Linear .
T = Drag the sliders left or
(None) —— L right
Toning effect: =}
{None) 2
Sharpness: [m=
() e

Display the values of the settings

Filter effect: Creates an image where the white of clouds and the
green of trees are emphasized in the same
monochrome photograph.

Filter Example of effect
None Ordinary monochrome image without filter effect.

Blue sky is reproduced more naturally and white

Yellow
clouds emerge clearly.
Orange Blue sky becomes somewhat darker. The
9 brightness of the setting sun increases further.
Blue sky becomes quite dark. Autumn leaves
Red :
become clear and bright.
Human skin tones and lips become softer. The
Green

green leaves of trees become clear and bright.

Toning effect: You can create a monochrome photograph to which a
single color has been added.
You can choose from [None], [Sepia], [Blue], [Purple]
and [Green].

A
~

=@< Increase the [Contrast] to emphasize the filter effect

To emphasize the filter effect, set the [Contrast] slider closer to the right.
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Introduction

Adjusting Sharpness '? Sharpness is unnatural e
You can make the overall atmosphere of an image harder or softer. Adjust sharpness with the window view set to [100% view], [50% view] E—
Move the slider to the right to make an image harder and to the left to or [200% view]. If the view is set to [Fit to window] (full view), the o Glance.
make an image softer. sharpness may seem unnatural.

[Penrs e (L5 _J——Reverts the image to & The adjustment range is 0 to 10 (in 1-stop increments). opBea,.Z;fon
Standard f 3] { Browse... the original Settings
Advanced
Op ion
100 80 -60 40 -20 0 20 48 Advanced
Contrast Image Editing
i b4 and Printing
Highlight: ; "\_" .
o Processing
A — Large Numbers
] Linear of Images
Colar tone: ™
. o
- - Editing
-[EDc]u ar saturation: PR— .? A JPEGI/TIFF
; Images
Sharpness:
(n =
Drag the slider left or right Reference
Display the value of the setting —
Index



Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.122). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click on the [RGB] tab sheet and click the desired

automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most

images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.
raw [[“RGB |} NR/Lens/ALO
[FnErEE 1 |7+ Jizs | Reverts the tone curve
Tone curve adjustment =3 to the original settings
L ED 7]
255 Al High
Standard
D ]
o 255
Brightness: 0 i
Caontrast: ‘
Huse:
Saturation:
Sharpness:

The tone curve changes as adjusted.

¥

=@< Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

* Images which have been shot with the proper exposure

* Images where the brightness is unbalanced

* Images which are too dark

* Images which have extreme backlighting

(D Ifyou click the [[I25])] button, the tone curve as well as the [Hue] and
[Saturation] revert to the default settings. Take care when adjusting
the [Hue] and [Saturation] individually (p.91).
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Editing Efficiently
Editing in the Edit Image Window

The thumbnail display and the edit window are combined and images can
be edited efficiently while quickly switching between images to be edited.
Images to be edited are selected beforehand in the main window.

In the main window, select the images you want to edit.

Switch to the edit image window.

Click

The main window switches to the edit image window.

Edit the image.
Change the size
Edit image window

@ Digital Photo Professi File Adjustment  Tools | Window Help

nnnnnn

..........

aaaaaaaa

uuuuuuuuuu

Select the image to be edited
The selected image is displayed as an enlargement in the
middle of the window

It may take time for the image to redraw itself.

The same tool palette as in the edit window is displayed and you
can edit the image.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <38> +
<Z> keys.

|§| By selecting the [View] menu » [AF Point] in the edit window or edit
image window, you can display the AF points selected in the
camera at the time of shooting. However, AF points are not
displayed for images which have had their image size changed and
then been converted and saved (p.39, p.116).
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Double-click the area you want to enlarge.

@ Digi

fession: = 4 Wed318PM

Double-
click

The area you double-clicked is enlarged to 100% (actual pixel
size).

To change the display position, drag on the image or drag the
enlargement display position (p.111) of the tool palette.
Double-click again to revert to the full view ([Fit to window]).

To return to the main window, click the [Main Window] button on
the toolbar.

-:@/E To display an image in an enlargement ratio other than 100%

Click the [50% view] or [200% view] on the toolbar.

5

You can change the way the tool palette is displayed (p.76).

You can change the enlargement ratio when you double-click
(p.75).

With the edit image window, you can only select images from one
folder. To gather images from several folders for editing, refer to
“Gathering and Editing Images in the Collection Window” (p.33).
For a list of edit image window functions, refer to p.115.
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Changing the Thumbnail Display Position to a Horizontal Position

Select the [View] menu » [Change thumbnail

-

If you select [Change thumbnail position] again, the thumbnail
display reverts to the vertical position.

Gathering and Editing Images in the Collection Window

You can gather any randomly selected images together in the
[Collection] window for viewing, comparison and editing. You can gather
images from several folders as well as from only one folder, allowing you
to work with them efficiently.

Select images from the [Folder] window in the main

window, and select the [File] menu » [Add to collection].

Open in Edit window ®O
Open in Edit window (enlarged)
Close all
Open window 3N
Close window HEW
Save S
Save As... {r365
Add thumbnail to image and save (3T
Convert and save... ®D
Batch process... #B
Create new folder... {r 38N
Page setup... {+ 3P
Print... 3EP
Print with detailed setting... 3D
Contact Sheet Prints... ~ 3P
Plug-in printing [ 3
[ Add to collection #®G0
Remave from collection 1ir3kG

The selected images are added to the [Collection] window and the
number of selected images is shown on the [Collection] tab sheet.
When you add RAW and JPEG images displayed as a single
image (p.20), the number of images shown on the [Collection]
tab sheet increases by 2.

You can select several images and add them to the [Collection]
window.

You can also add images to the [Collection] window by selecting
images, clicking on the image while holding down the <control>
key, and selecting [Add to collection] from the menu that appears.
You can add up to 1,000 images to the [Collection] window.
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Select the [Collection] tab sheet.
000

Folder Collection(14)
¥ = MacOsX
b | A Applications
[% Temporary Items vy
¥ |+ Users
v & canon

=

The selected images are displayed in the [Collection] window.

Check displayed images in the [Collection] window.

= 4 Wed4:03PM @

& Digital Photo Professional File Edit View Bookmark Adjustment Tools Window Help
806

Digital Photo Professional - [ Collection ]

Adobe RGH / Adobe RGE igh quality Recipe data: ves Number of mages: 15 NamSar ot tieeei Tsgess 1 D CHTR 7

Edit the images.
You can now edit the images displayed in the [Collection]
window.
Images displayed in the [Collection] window are retained in the
[Collection] window even after exiting DPP.

¥

=@< To remove images from the [Collection] window

Removing randomly selected images
Select the images to be removed in the [Collection] window and then
select [Remove from collection] in the [File] menu. (You can also remove
images from the [Collection] window by selecting the images, clicking on
the image while holding down the <control> key, and selecting [Remove
from collection] from the menu that appears.)
Note that even if you remove an image from the [Collection] window, the
original image remains unaffected.

Removing all images
Select [Clear collection] in the [File] menu. (You can also remove all
images from the [Collection] window by clicking while holding down the
<control> key, and selecting [Clear collection] from the menu that
appears.)
Note that even if you remove all images from the [Collection] window,
the original images remain unaffected.

@ Modifications to the image are applied to the original image
Modifications made to images added to the [Collection] window are
all applied to the original image.

ﬁl You can arrange images displayed in the [Collection] window the
same way as in the [Folder] window (p.18, p.19). You can
maintain the order of rearranged images even after quitting DPP
by checkmarking [Retain sort order] on the [View settings] tab
sheet in the [Preferences] (p.75).
You cannot use the following functions in the [Collection] window.
« Starting of EOS Utility (p.7), or synchronizing of folders with

EOS Utility

» Batch change the file name of images (p.85)
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Trimming and Adjusting the Angle of an Image

Adjust the angle of the image as needed.
Trimming/angle adjustment window

[ 1/1 IMG_0001.CR2 [3456 x 2304]

You can trim only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical. You can also adjust the angle of an image before trimming.
When aspect ratio information is attached to an image shot with the
EOS-1D Mark 1V, EOS-1Ds Mark Ill, EOS-1D Mark Ill or EOS 7D, the
trimming range based on the aspect ratio information is displayed.

Select the image to be trimmed.

Open the trimming/angle adjustment window.

Select the [Tools] menu » [Start Trimming/Angle Adjustment tool].

Start EQS Utility MC3EE
Transfer to Photoshop N3P
Start Quick check tool EF
[ Start Trimming/Angle Adjustment tool X %T )
Start Stamp tool N3ES
Start Rename tool ¥R
/nc folder with EOS Utility

The trimming/angle adjustment window appears.
Editing can be done once the trimming/angle adjustment window
has reached a clear display.

Largest
possible
trimming
range

= — Click (rotate

image left
or right in
90-degree
increments)

|
Drag* (0.01-degree increments;

adjustment range: -45 to +45 degrees)

Use the mouse (click A/V) to adjust the angle or
directly enter the adjustment angle* (0.01-degree
increments; adjustable range: -45 to +45 degrees)

* You cannot adjust the angle of images that exceed 6666 x 4444

pixels in size.

If you click [Center on Screen], you can display the trimming

range in the center of the window.

When correcting lens aberrations, it is recommended to perform
[Lens aberration correction] before adjusting the angle of the

image.

If you click the [OK] button after adjusting only the angle of the
image, the image will be trimmed at the largest possible trimming

range.
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Introduction
Select a ratio and drag the trimming range. Click the [OK] button to return to the main window.
ece The trimming range frame is displayed in the trimmed image
—Cancel (p.109). Contents at
When the trimmed image is displayed in an edit window or the a Glance
s B S.elecjt a edit image window, it is displayed in its trimmed form. —
trimming
ratio Basic
_ Drag the Operation
: , trimming
: range Ad\aced
e Ope#étion
Advanced
e e - Image Editing
and Printing
The trimming range can be moved by dragging.
You can enlarge or reduce the size of the trimming range by Processing
dragging the four corners of the trimming range. Large Numbers
List of aspect ratios (width : height) of Images
o Free Editing
1l JPEGI/TIFF
3:7 Images
2:3
4:3
3-4 Reference
5:4 -
4:5
A Size Landscape Index
A Size Portrait
Letter Landscape —
Letter Portrait
Custom @ @

selectable ratio.

[Free]: You can trim an image to any size, regardless of the @
[Custom]: You can trim an image at the specified ratio.



? About trimmed images

The trimmed range can be reverted to its original condition at
any time

A trimmed image is displayed or printed as a trimmed image.
However, since the image is not actually trimmed, you can always
revert to the original image by clicking the [Reset] button in the
trimming/angle adjustment window or performing the “Re-Editing an
Image” procedure (p.40).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.109).

 Edit window: The image is displayed in its trimmed condition.

« Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when converted and saved
The trimmed RAW image actually becomes a trimmed image when
converted to a JPEG or TIFF image and saved (p.39).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to an image shot with EOS-
1D Mark 1V, EOS-1Ds Mark 1ll, EOS-1D Mark Ill or EOS 7D, the set
trimming range based on the aspect ratio information is displayed.
However, since the image is not actually trimmed, you can change the
trimming range or revert to the condition before trimming.

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.117).

¥

== Convenient functions of the trimming/angle adjustment
window

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming/angle
adjustment window. With the trimmed image displayed, click the
[Copy] button and then click the [Apply All] button. This will apply the
trimming range to all the images selected when the trimming/angle
adjustment window is displayed.

To select multiple images in the main window, click the images while
holding down the <38 > key. To select multiple consecutive images,
click on the first image, and then click on the last image while holding
down the <shift> key.

® For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view image details in the trimming/
angle adjustment window, so using this function is not
recommended.

@ For a list of the trimming/angle adjustment window functions, refer
to p.117.

Introduction

Contents at
a Glance

Basic

Operation

Advanced
Op ion

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00

37



Applying Adjustment Contents to Other Images

You can copy the image adjustment contents (recipe) adjusted with the
tool palette and apply it to other images.

You can efficiently adjust multiple images by adjusting one image and
applying the results of this to multiple images shot in similar shooting
environment.

Select the adjusted image and then select the [Edit]

menu » [Copy recipe to clipboard].
The recipe is copied.

Select the image to which the recipe is to be applied
and then select the [Edit] menu P [Paste recipe to
selected image].

The recipe is applied to the image.

|§| The recipe (p.80) can be saved as a separate file from the image
and loaded and applied to another image (p.81).

Saving Editing Results
Saving Editing Contents to a RAW Image

All the contents (recipe) adjusted with the tool palette as well as the
trimmed (p.35) range information can be saved to a RAW image orto a
separate RAW image.

The adjustments made with the tool palette (p.53 to p.63) and the dust
erase processing explained in Chapter 3 (p.64 to p.68) can also be
saved in a RAW image.

Select the [File] menu » desired item.

Open in Edit window ¥0
Open in Edit window (enlarged)

Close all

Open window N
Close window HEW
Save 3ES

Save As... {r3S

Add thumbnail to image and save {3ET
Convert and save... #D
Batch process... 3B

Create new folder... {r3#EN
Page setup... {r3EP

Print... 3EP

Print with detailed setting... {+3D
Contact Sheet Prints... ~3EP

Plug-in printing [
Add to collection #G

Remove from collection {r3G

Clear collection

Delete 3 <
Info... #l

Your adjustments are saved to the image.
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Saving as a JPEG or TIFF Image

To view, edit and print a RAW image with software other than DPP,
convert to a more versatile JPEG or TIFF image and save.

The image is saved as a separate image, so the RAW image remains
unaffected.

Select the image to be converted.

Select the [File] menu » [Convert and save].

Open in Edit window HO

Open in Edit window (enlarged)
Close all

Close window HW

Save £S5
Save As... {+ 385
' Convert and save... ®D l

Batch process... 3B
Create new folder... 13N
Page setup... {+38P
Print... 3P
Print with detailed setting... {+3D
Contact Sheet Prints... ~HP
Plug-in printing 2
Add to collection H#G
Remave from collection 138G
Clear collection

Delete E: |
Info... #l

The [Convert and save] window appears.

Specify the necessary settings, and then click the
[Save] button.
By default, the image is converted and saved to a JPEG image

with the highest image quality, without changing the image size.

Change the settings according to your requirements.

Convert and save
(Save As: | DPP_001 (+) '—
( Where: [ Photo ﬂ )7
File format
(Kind of file Exif-JPEG f ¢])7
Image quality i e 10
Output setting
Output resolution 350 dpi [} Embed ICC profile
Resize setting
] Resize
Width Height Unit
3504 x 2336 pi:
{3504 pixel ) {2336 pixel )
Aotk v
t Cancel ) Save

. Enter a file name

- Select the save
destination

—— Select an image type

—— Click and save

The RAW image is converted to a JPEG or TIFF image which is
then saved as a new image in the specified save destination.

Ay
~

-
- ~

currently using

To save the developing/editing results for the version you are

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.
Meaning that, between two differing versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe

may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, it is recommended that you convert and
save images as JPEG image or TIFF images.

@ By saving as explained on this page, a trimmed image (p.35) or
dust-erased image explained in Chapter 3 (p.64 to p.68) actually
becomes a trimmed image or dust-erased image.

You can reduce the noise characteristic of JPEG images which
occurs when you convert and save an image as a JPEG (p.73,

p.74).

You can batch convert and save multiple images (p.83).
For a list of [Convert and save] window functions, refer to p.116.
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.23 to p.30), so the “original image data itself”
remains unaffected.

Also, the trimming range information of a trimmed image (p.35) is simply
saved to the image.

For this reason, you can undo any adjustments saved (p.38) to the
image, trimming information, and revert to the condition when last
saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu P desired item.

Rotate Left #L
Rotate Right R
Add check markl H#F1
Add check mark2 HF2
Add check mark3 HF3
Clear check mark HFa
Work color space e
Tone curve assist - Standard

Tone curve assist - High

Revert to last saved settings “_3Z
Revert to shot settings ~¥Z

The image reverts to the conditions of the selected item.

Printing an Image

This section explains how to print high-resolution photographs easily
with Canon inkjet printers compatible with the Canon printing software,
Easy-PhotoPrint EX or Easy-PhotoPrint. It also explains how to print
photographs using other printers.

Proceed to the page for the printer you are using.
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint EX (Same page)
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint (p.43)
Printing Photographs with a Printer other than Canon Inkjet Printers

(p.46)

Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint EX

You can perform the following types of photograph printing with Canon
inkjet printers compatible with Easy-PhotoPrint EX (hereinafter, “EPP
EX"):

Simple printing of RAW images

Printing with faithful colors

To perform this printing, it is necessary to first install EPP EX version 1.1
or later on your computer.
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Introduction
Select the image to be printed. In [Print Quality], select [Quality Priority], click the
[Option] button, and then in the dialog box that
Start up EPP EX. appears, checkmark [Print with the best quality when Contents at
Select the [File] menu » [Plug-in printing] » [Print with Easy- you select [Quality Priority]]. (EELED
PhOtOPrInt EX] (@00 Preferences h
Print Advanced Basi?
Open in Edit window %0 o _ 5 . Operation
Open in Edit window (enlarged) HomRstel FeRle 8 RS
Close all Printing Order By Date ?]
.:- |- .I.- window 38 by Amount of extension of borderless printing Default A
Close window PEW Print Quality : [ Quality Priority jli— Select Og%(e)g
Save 35 (C ostion.. ) Qqalfty
Save As... {+3#S PI’IOI’Ity
Add thumbnail to image and save 3T Advanced
Convert and save... #D Image Editing
Batch process... #B and Printing
Create new folder... 3N
Processing
L Ly ~ Defaults ) Large Numbers
Print... _ _ %P of Images
Print with detailed setting... {+3ED - -
Contact Sheet Prints... ~ P (Kl ) ( Cancel ) 0K )
Plug-in p g = Editing
Add to collection sec A1 ol Click and checkmark [Print with the best quality J'?rﬁgg;f':
Remove from collection T #G when you select [Quality Priority]] S
EPP EX starts up.
P Select the [Advanced] tab, checkmark [Enable ICC S
In the EPP EX window, select the [File] menu » profile], and then click the [OK] button.
[Preferences]. The [Preferences] window closes.
| : Index
My Recent Files »

Next Step @ @
Preferences... @

The [Preferences] window appears.




Specify the number of sheets to be printed, and then
click [Select Paper].

EPP EX

806

Photo Print

Specify the number of copies to print for eact

New Photo Print - Easy-PhotoPrint EX

h image.

Exif Frin!

“m%

MG, nu@ 1MG_0007.CR2

e 2= =

1 = IMG_0001.CR2 ING_0002.CR2 IMG_0003.CR2 IMG_0004.CR2 |Mc nuns m
(@ Gyt || A 0= &= &)
o AR
IMG_0008.CR2 IMG_0009.CR2 IMG_0010.CR2 IMG_0011.CR2 IMG_0012.CR2
@@ &) {52/ m || =0 A =0E
A
....... o)
g - E = 5 =
[ wep | ] o .
Exit

IMG_0013.CR2

EE

=

IMG_0007.CR2

mc 0014.CR2

&=

IMG_0008.CR2

— Click to
increasethe
number of
sheets to be
printed

Click

Select the paper type, and then click the [Layout/

Print] button.

806 New Photo Print - Easy-PhotoPrint EX

Select the printer to use, then select he size and type of paper for printing

Photo Print

Printer. Canon XXX )

Norma

ges
@ select Paper

Exif Print

=== 1l

Letter A4 R Photc

Mar

#
B

D
[

v TR

_

R g Kol

Glossy Photo Paper

Phin Paper

Select the

[T
[—T—

Click

paper size
and type

Specify the layout, and then click the [Print] button.

8066

New Photo Print - Easy-PhotoPrint EX

Photo Print

[

Exif Print

— kT
nep || e
|

Inside Pages.

Huﬁd&ﬂjg

Click to print

Printing begins.

Select the
layout

J
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Introduction

"2 Additional information Printing Photographs with Canon Inkjet

Print up to 1000 images at a time Printers Compatible with Easy-PhotoPrint

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

Contents at
You can perform the following types of photograph printing with Canon a Glance

inkjet printers compatible with Easy-PhotoPrint (hereinafter, “EPP”):

The printed image’s color is not what you expected Simple printing of RAW images
In the EPP EX window, select [Preferences] in the [File] menu and High quality printing using the color reproduction range of Adobe RGB o Bas't?
then click the [Advanced] tab in the [Preferences] window to display and a Canon inkjet printer peration
the [Advanced] tab sheet.
In the [Advanced] tab sheet, select [Enable ICC profile] in [Color To perform this printing, it is necessary to first install EPP version 3.5 or
correction for printing] and try printing using the [Perceptual] setting later on your computer. When using an Easy-PhotoPrint EX-compatible Sd%gg
(p.123). inkjet printer, it is recommended that you print using Easy-PhotoPrint EX P.
(p.40).
|§| DPP is also compatible for printing with Easy-PhotoPrint Pro (p.71) : : &
y P-11). Select the image to be printed. Image Editing
and Printing
Start up EPP. Processing
Select the [File] menu » [Plug-in printing] » [Print with Easy- Large Numbers
PhotoPrint]. of Images
|
e Editin
Open f" E !t an ow %0 JPEG/TIFF
9?6? |n”Ed|t window (enlarged) Images
Close window W
e 325 Reference
Save As... {r 385
Add thumbnail to image and save {3#T
Convert and save... #D
Batch process... ®B Index
Create new folder... i+ 3N \ )
Page setup... ir3EP
Print... P
Print with detailed setting... {+3D @ @
Contact Sheet Prints... ~ 3P
Plug D g Print with Easy-PhotoPrint  38E
Add to collection XC @
Remove from collection {+ 386G

EPP starts up. 43



In the EPP window, select the [Easy-PhotoPrint]

menu » [Preferences].

Easy-PhotoPrint
About Easy-PhotoPrint...
‘ Preferences... &, |

Services |

Hide Easy-PhotoPrint 3H
Hide Others C#H
Show All

Quit Easy-PhotoPrint  3Q

The [Preferences] window appears.

In [Print Quality], select [Quality Priority].

Preferences

[Cprint | Advanced |

Print Number of copies : 1 ’? Copies
Printing Order : By Date Hi
Amount of extension of " Default F
borderless printing :
Print Quality : [ Quality Priority I"ﬁ

]_

® ( Cancel )M

— Select
Quality
Priority

Select the [Advanced] tab sheet and check that the
EPP image compensation function is disabled.
If not disabled, the operation of the EPP image compensation
function may prevent images being printed with faithful color
reproduction.

Preferences
[T I
{ Print | Advanced )
Image E}Dptimize images automatically If _CheCked’
gApply Rotate/Trimming to the same images in the same manner CIICk to
When landscape images are rotated depending on the selected remove the
e Rotate Left Check mark
) Rotate Right
Layout 1 Always trim when you select the layout with the margins
ESet margins to the minimum when you select the layout
with the margins
E Print filename when you select the index in layout
E Preview all layouts of A4 and Letter
Image | Select images from multiple folders .
Selection CI|Ck tO
close the
| Defaults ) window
@ ( Cancel ) lf—ex——;)'

Specify the number of sheets to be printed, and then
click [Next].

806 Easy-PhotoPrint
bty PhotoPrint [ SRIaas et SR
— Click
—Click to
increase the
number of
sheets to be
printed

J
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Introduction
Check that the image compensation function is

disabled, select the paper type and then click [Next].
If checked, click to remove the check marks

Additional information

© Print up to 1000 images at a time T
You can print up to 1000 images selected in DPP at a time. When a Glance
printing more than 1000 images, divide the printing into several jobs.

© The printed image’s color is not what you expected

Click Change the [Rendering intents when using Easy-PhotoPrint] (p.77) to Basic

[Perceptual] (p.123) and print. Operation

6 06 Easy-PhotoPrint

7 Paper Selection

Cvid Photo

[_|Rhoto Noise Reduction : Normal

Paper Size : Media Type :

. D ® In a Mac OS X 10.6 environment, the Apple application Rosetta Ad%ed
" Select the must be installed beforehand to use EPP. Opgiation

aper type
papertyp @ DPP is also compatible for printing with Easy-PhotoPrint Pro (p.71).

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

19 Page (s) L

8 Specify the layout, and then click [Print]. | FI,Eg(i;tli_l;_llgF .
- Images

Easy-PhotoPrint

EasyiPhotoPrint e L

Click to print

Reference

Index

Select the layout @

=» Printing begins.
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Organizing Images
This section explains how to delete unwanted images, create folders for
saving images, move or copy images, etc., and organize your images.

Introduction
Printing Photographs with a Printer other than Canon Inkjet Printers

You can print one image on one sheet of paper.

Contents at

. a Glance
Select the image to be printed. Deleting an Unwanted Image
Be aware that you cannot recover deleted images.
Select the [File] menu » [Print]. hiH
. . . . Operation
Select an unwanted image in the main window.
Open in Edit window #O
Open in Edit window {entargedy Select the [File] menu » [Delete]. éd%ed
Close all p ion
Close window W Open in Edit window ®0
o %S Open in Edit window (enlarged) Advanced
SuvR AT s Close all Image Editing
Add thumbnail to image and save {r3T SpEl] WGy il and Printing
Convert and save... ®D Close window it
Batch process... B Save 385 Processing
Save As... {1 35S Large Numbers
Lreatenew folters DN Add thumbnail to image and save {r3T of Images
Page setup... 1 3EP Convert and save... 0D
[ Print... #P ) Batch process... ¥#B 5
Print with detailed setting... 4D JPEEdg/I%gFF
Contact Sheet Prints... ~3P Create new folder... raN Imades
Plug-in printing > Page setup... 11 36P J
Add to collection ®C Pr?nt...l = = =
R R e el aetion ARC Print with detailed setting... 3D
Clast collaction Contact Sheet Prints... ~3EP Reference
Plug-in printing »
Delete 38 <=l :
Nl %] Add to collection ¥C
Remove from collection {+38C
The [Print] dialog box appears. Clear collection Index
Set to photograph printing and print. ID*;'EW :f’) —
Specify the optimum settings for photograph printing in the & O": : .
printer’s print settings dialog box and click the [Print] button. The image is moved to the [Trash] and is deleted from DPP. @ @
Printing begins. The images are deleted completely from your computer by
selecting the [Finder] menu » [Empty Trash] on the desktop.
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Creating a Folder for Saving Images

You can create a folder for sorting images.

In the folder area, select the location where the new

folder is to be created.

806 Digital Photo Prof

Iy,
1113

Folder Collection(0)
¥ 24 MacOsX
» [N Applications
¥ Temporary Items
¥ |+ Users
¥ 4 canon
P [ Desktop

» % Documents
» (@ Library

|® Movies

[& Music

> [ Sites
» | Shared

Select the [File] menu » [Create new folder].

Open in Edit window #0
Open in Edit window (enlarged)

Close all

Open window 3N
Close window EW
Save 35
Save As... i+ 385
Add thumbnail to image and save 3T
Convert and save... #D
Batch process... #*B

( Create new folder... 13N )

Page setup... 3P
Print... 2EP
Print with detailed setting... {+3D

The dialog box for entering a folder name appears.

Enter a folder name and click the [OK] button.

The new folder is created in the folder selected in step 1.

Moving Images

You can move or copy images to a separate folder and sort by shooting

date or themes.

Drag the image to be moved or copied.

To move: Drag the image and release when the image is in the

destination folder.

To copy: Drag the image while holding down the <option> key
and release when the image is in the destination

folder.

8086 Digital Photo Professional

T}
113

Folder Collection(0)
¥ = Macosx 7
» [& Applications -
|2 Temporary Items
v & Users
v @ canon
¥ [@ Desktop
L2 Travel
» | ¥ Documents
» [# Library ®
[ Movies IMG_0001.CR2 IMC_0002.CR.
& Music
¥ (il Pictures
v [7 photo
L0 XXXX_XX_XX
b @ Public
> [ Sites
» [ Shared

[ 4%

The images are moved or copied to the destination folder.

@ In a Mac OS X 10.6 environment, you cannot move files or folders in

the folder area.
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Moving Images in Folders

You can move or copy folders that contain images, and sort the images
by folders.

Drag the folder to be moved or copied.
To move: Drag the folder and release when the folder is in the
destination folder.
To copy: Drag the folder while holding down the <option> key

and release when the folder is in the destination folder.

806 Digital Phata Professional

Folder Collection(0)

"
i

v Macosx
» | A Applications
(7 Temporary Items
¥ (& Users
v & canon
¥ [ Desktop
[ Travel
» [ Documents
» |# Library
| = Movies

IMG_D0D1.CR2 IMG_0002.CR;

The folders are moved or copied to the destination folder.

® Ina Mac OS X 10.6 environment, you cannot move files or folders in
the folder area.

Registering Frequent-Use Folders (Bookmark Registration)

You can register frequently used folders in bookmarks.
Registered folders appear by clicking the [Bookmark] menu.

Select the folder for which a bookmark is to be

registered
9 .
8enn Digital Photo Professional
Folder Collection(0)
¥ = Macosx T
» [A Applications =
(7 Temporary Items i
¥ & Users .
v @ canon ‘
¥ [ Desktop
L% Travel u
B |¥ Documents
> & Librar
' @ @
[® Movies IMG_0001.CR2

& Music i
¥ |2 Pictures
v [t

The folder selected in step 1 is registered in the [Bookmark]
menu.

Select a registered folder from the [Bookmark] menu to display
images in the selected folder in the main window.

Organizing Bookmarks

You can change a folder name or delete a folder registered in
[Bookmark].

Select the [Bookmark] menu » [Organize].
The [Sort bookmarks] window appears and you can change
folder names or delete folders.
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3 Advanced Image Editing and Printing

Introduction
Various preferences including advanced image adjustment, automatic Performing Automatic Dust Erasure Processing _____ 64 T
dust erasure processing, various printing functions for printing out work, Compatible Cameras......ccccccceeeeveeeiccciiiiiiieeeeeee e 64 Contents at
and color management are explained here, geared to the user who is Automatic Dust Erasure Processing in the Main Windo 65 :r(';fannzea
competent in the handling of third-party image editing software. u ictu u Ing | ! : W... -
Manually Erasing Dust (Repair Function)................ 66 _
Adjusting While Comparing with the Original Image... 50 Erasing Unwanted Parts of an Image (Copy Stamp Opeation
Changing How the Window is Split...........cc.ccccon...... 50 LU oo (o] o) TS 68 ‘S
Adjusting by Comparing Multiple Images................. 51 Transferring a RAW Image to Photoshop................ 68 Advanced
Displaying an Area Beyond the Set Range as a Setting Work Color Space .........cccooeevveeviiiiieeeeinnnnn. 68 e
Warning Indicator (Highlight/Shadow Warning)....... 52 Printing with Shooting Information............c....c......... 69
Pel"fOI’mIng Advanced Ed|t|ng ................................... 53 Prlntlng a Thumbnall LlSt (Contact Sheet Prlntlng) 70 Ig‘nadg\a#::]ngg
Adjusting White Balance with Color Temperature ..... 53 Printing RAW Images on a High-End Canon Printer.. 71
Tu'nlng' White Bal.ance with Color Wheel ................... 53 Printing with a High-End Canon Inkjet Printer ............ 71 J.-L%"ﬁﬁﬁfﬂeg’rs
Adj'ust!ng Dynamlc Range .............. s 54 Printing with a Large-Format Canon Printer.............. 72 of Images
Adjusting Brlgh.tness of Shadows/Highiights ............ o4 Specifying Preferences............ccccoccvvvvviieviieeeeieennne. 73 Editing
Tone Curve Adjustment..........cccooooiiiiiiiiiiiee, 55 General Settings 73 JPEG/TIFF
G 7 General Settings . Images
Example of a Tone Curve Operation ..................... 56 View Settings 75
Using a Picture Style File..........cccccooeiiiiiiiiiiiiieeeeee, 56 Tool Palette 76
About the RGB Tool Palette ..............cc.coceuevrrrrennnn. 57 Color Manag’é'r'r'];r']'t' """"""""""""""""""""""""""""""" -- [
Using the Auto Lighting Optimizer............ccccccceeenn... 58 -
Reducing NOISE ........coviiiiiiiii e 59 Index
Correcting Lens Aberration ...........ccccooeveeeiiiiiincnnnnn. 60 )
Compatible Cameras.........ccccceeeeiiiiiii 60
Compatible Lenses......cccoeeeeeeiieiiieiii 60 @ @
Making Corrections..........cccueeeeeeeeeeeeiiiiciiirieeeeeeee. 62
About Shooting Distance Information Slider.............. 63 @
Correcting Multiple Images ata Time...........cccceeee..... 63
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Adjusting While Comparing with the Original Image

You can display before and after versions of an adjusted image in the
same window and adjust while checking the adjustment results.

Introduction
Changing How the Window is Split N

You can change the display of the image to a single image split in two.

In the edit window, select the [View] menu » [Before/ c:r(';tfanr:cs;eat

after comparison]. In the edit window, select the [View] menu » [Display L __________
mode] » [Split smgle |mage]

Basic
Operation

N —

Advanced
Operation

Imag\aﬂtmg
and Pfinting

= One image is divided and dlsplayed on the left and right or top
The image divides into a left and right window. and bottom. Processing
The window on the right shows the image after editing. To switch between top and bottom, and left and right, perform the Large Numbers

of Images
same operation as step 2 on the left page. u._ga

Change the image display.
Select the [View] menu » [Change up/down/left/right] » [Up/ Editing

down]. JPEGI/TIFF
Images

|

Reference

|

Index

R e N
(502, 1600 76, 17,102 J X

The layout of the two images changes to top and bottom.
The bottom window shows the image after editing. @

|

|§| Images can also be displayed in the edit image window by the same
operation.



Adjusting by Comparing Multiple Images e
You can synchronize the display position of multiple edit windows and Move the display position.
adjust images while comparing them with each other. If you move the enlargement display position in one of the edit
T : : : windows, the enlargement display position will also change in the Contents at
In the edit window, display the multiple images to be other edit windows. a Glance
compared. To cancel synchronization, select the [Window] menu »
. . hroni in.
Align the images. [Synchronize] again Basic
Align the images for easy comparison. Operation
Select the [Window] menu » [Synchronize].
deanced
. pr
Enlarge the image. e

Enlarge and display any of the edit windows.

R e e Advapced
r Imag iting
and Pfinting
[ € 4 LM"«?“"“ .
. @ Processing
T o = _“Ar : Large Numbers
| e WA : of Images
T e Editing
JPEGI/TIFF
Images
‘ =¥
5
P Reference
P
Sand
RAW e lcmx%,‘
oo . . . Index
The other edit windows will also be displayed in the same
position/enlargement ratio. —

@ Synchronization only applies to the enlargement display position ~
and the enlargement ratio. Adjustments to the images are not

synchronized.
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Displaying an Area Beyond the Set Range as a Warning Indicator (Highlight/'Shadow Warning)

You can set up a warning indicator in both the highlighted part and the
shaded part, which is effective for checking the light and dark areas and
preventing excessive adjustment of an image. Where the area on the
image has exceeded that set range, you can display the highlighted part
in red and the shaded part in blue.

Select the [Digital Photo Professional] menu »
[Preferences].

Select the [View settings] tab sheet.

Enter the warning value for [Highlight] and [Shadow].

Fr 2|
Preferences

General settings | Miew settings | Tool palette Color management

Grid pitch
64 Pixels(8-256)

Locking selected image
B Images opened in Edit window remain selected in main window

Magnification in Edit window

{® Fit to window O 50% O 100% O 200%

Magnification when the Edit/Edit image window is double-clicked

® s50% O 100% O 200%

RAW and JPEG
Eﬁ Display only CR2 images for CR2 and JPEG files of the same name

Sort order in main window
# Retain sort order

Highlight/shadow warning

Highlight 255 | (9z-255 [N
Shadow o | (o-64 ]

Quick check tool display

® 508 () 100% (moiré reduction off)

I Cancel 3 f 0K )

Click the [OK] button to close the window.

Display the edit window.

Select the [View] menu » [Highlight]. Similarly, select
[Shadow].

On the opened image, if there is an area that exceeds the value
entered in step 3, the highlighted part of that area is displayed in
red and the shaded part is displayed in blue.

@ You can also display the warning with the same operation in the edit

image window.

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advapced
Imag iting
and Pfinting

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00

52



Performing Advanced Editing

This section explains how to use the advanced adjustment function on
the tool palette in the edit window.

Adjustments made using the high-level functions of the [RAW] and
[RGB] tool palettes, as well as the functions of the [NR/Lens/ALO] tool
palette are explained in this section.

Adjusting White Balance with Color Temperature

White balance can be adjusted by setting a numerical value for color
temperature.

Select [Color temperature] from the [White balance
adjustment] list box.

Set the color temperature.

—--——[ RAW | RGB NR/LensfALD
|Erightness adjustment [ = |

||||||=||||-|.q|||||-=|||- 0.00
|White balance adjustment | :‘

|?| | 1 | F 3 Register...
[r Calor temperature ':]y Tune:z——9

) .
= (seo0_k)——— Display the value of the

setting
Drag the slider left or right

|§| The adjustment range is 2500 to 10000K (in 100K units).

Tuning White Balance with Color Wheel

White balance can be tuned by moving a cursor in the color direction
shown in the color wheel.

In the [RAW] tool palette, click the [Tune] button.

Tune by dragging a point.
You can also fine-tune your adjustment by directly entering the
adjustment values.

enn White balance fine adjustment
Calor tone: —— Enter the values
Color saturation: tO Set

Cancel (‘ 0K }

Drag

@ To register adjustment results as personal white balance (p.82),
select a setting other than [Shot settings] from the [White balance
adjustment] list box, and then tune with the color wheel. You cannot
register the adjustment results as personal white balance when you
have selected [Shot settings] from the list box and have done any
tuning.

@ The adjustment range of color tone is 0 to 359 (1 unit in numerical
value input), and the adjustment range of color saturation is 0 to 255
(1 unit in numerical value input).
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Introduction
Adjusting Dynamic Range Adjusting Brightness of Shadows/Highlights
Dynamic range (width of gradation expression) from dark points to bright You can adjust the brightness of shadows and highlights in an image.
points in an image can be adjusted. By adjusting shadows and highlights in an image with a restricted C:rgfanr:(s:eat
brightness, you can reduce the effects of clipping in shadows and
‘ Picture Style -+ hlgh“ghts
= —— Move downwards Basic
Ed_‘"d _'_'] e 1| QOutput highlight points [Peture e 5] pHgRE
Standard -:]'/. Browse... |
— Move to the left or right I [ E Advanced
Input highlight points Operation
10,0 \ i /4.0
Contrast: L= Adaﬁed
o) HEIRE R A " Imag iting
ke o Move upwards . S10.0 -8.0 -6.0 40 -20 0 2.0 40 and Pfinting
(0) SR e S Output shadow points «[:D?nrrast: —
Shadow - ok @ Drag the sliders left or Processing
Yt (0) : — : right Large Numbers
E;:]nlor tone: = [%‘]ﬂdow'- i sz . of Images
Color saturation: ¥ ! Linear
]} s Color tone: - Editing
Sharpness: = 10 ' ik JPEG/TIFF
(1) A ] Color saturation: = |mages
. (o) (R R S S A T
Move to the left or right Sharpness: -8
Input shadow points (n Y
Reference
The horizontal axis shows the input level and the vertical axis
shows the output level.
Index

Q0
O
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Introduction

Tone Curve Adjustment Make adjustments.
Batch adjusts RGB

You can adjust the brightness, contrast and color of a specific area by

. Adjusts each channel
changing the tone curve (p.122). ) Corgfnts at
——— RAW [“RGB~| NE/Lens (ALD &l e
In the tool palette, select the [RGB] tab sheet. [Tone chrve assist R
Tone cprve adjustment -y | Basic
. . T# 01w | g Operation
Select the tone curve mode and interpolation RG] = | < | s | a °
method. =2
| RAW | RGB | NR/Lens/ALO gd\é?:tci‘.gg
|Tone Curve assist Ol E2e P
Tone curve adjustment -y ‘
1 = . . Advanced
255 Adjust by dragging [[] and Pfinting
Processing
Large Numbers
v Curve | of Images
Straight o O .
<control> + click inside 0 255 Editing
v SGB_R GE = the graph to display the Epiginees —— 0 _ JPEG/TIFF
uminance menu A — - Images
Hue: e 2 o w
—— Saturation: o o0] Reference
R = _d Sharpness: o A— - [ ol
0 s s ) =
Bonhies Wt v -] O The horizontal axis shows the input level and the vertical axis
Contrast i e shows the output level. Index
e ———— (o] : The maximum number of [[]] is 8. -
e —a—— o) 100 To delete a [[], double-click on the [[J].
Sharpness: lr\:/'l"—' H T 0l

. 00

The histogram display changes according to adjustment. You can

also fix the histogram display to the display before any @
adjustments (p.76). ~—~
The tone curve mode and interpolation method for a tone curve

can also be changed in [Preferences] (p.76). 55



Makes medium tones brighter

Example of a Tone Curve Operation

Makes medium tones darker

J

74

/

Makes tones harder

Makes tones softer

Using a Picture Style File

A Picture Style file is an extended function file of a Picture Style.

With DPP, you can apply to RAW images Picture Style files that you
have downloaded from Canon’s web site effective for various scenes or
Picture Style files created with “Picture Style Editor”. When using a
Picture Style file, save it to your computer beforehand.

Display the image to which the Picture Style file is to
be applied in the edit window (p.11).

Select the [RAW] tab sheet in the tool palette, and
click the [Browse] button.

‘ Picture Style iy ‘

Y ¥ E———
I Browse...

Standard

A

-10.0 -8.0 -6.0 -4.0 -2.0 O 2.0 4.0

The [Open] dialog box appears.

Select a Picture Style file saved on your computer,
and click the [Open] button.
The Picture Style file you selected is applied to an image.

To apply a different Picture Style file, follow the procedure from
step 2 again.

|§| The Picture Style files that you can apply to the camera are files with
the “.PF2” extension only. Furthermore, you cannot apply Picture
Style files with the extension “.PSE” to an image; however if such a
file is registered in the camera and the image is shot, the image will
display correctly.
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About the RGB Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens/ALO] tab sheets according to your editing
requirements.

The [RGB] tool palette functions are the same as ordinary image editing
software, such as tone curve adjustment that is explained here, with
which you can adjust RAW images.

However, because the adjustment width of the functions in the [RGB]
tool palette is wider than the [RAW] tool palette, the image color may be
saturated, or the image quality may deteriorate if you adjust too much.
Therefore we recommend for functions other than tone curve
adjustment (p.55) and automatic adjustment (p.30), that you adjust
images using the same functions available in the [RAW] tool palette.
Refer to Chapter 5 for explanations on functions of the [RGB] tool
palette other than tone curve adjustment.

E\@/E Using the tool palette

We recommend that as a general principle you edit RAW images using
the [RAW] tool palette. However, where the adjustment width with the
[RAW] tool palette is not wide enough and you wish to use the special
functions in the [RGB] tool palette, we recommend that you adjust your
images at the necessary lowest limit with the [RGB] tool palette after
having completed basic adjustment with the [RAW] tool palette.

Use the adjustment function of the [NR/Lens/ALO] tool palette (p.112)
when applying the Auto Lighting Optimizer (p.58), reducing noise (p.59)
or correcting aberration (p.60) after you have made any required
adjustments with the [RAW] and [RGB] tool palettes.
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Using the Auto Lighting Optimizer

If the shooting result is dark or the contrast is low, you can use the Auto Checkmark the checkbox.
Lighting Optimizer function to auto-correct the brightness and contrast,

Introduction

and obtain a more pleasant image. s
You can also change the settings of the image shot with the camera’s [Auto Lighting Optimizer Cgrgfan:(s:eat
Auto Lighting Optimizer function. @ — Checkmark
This function is compatible only with RAW images shot with EOS-1D i Staridard St
Mark IV, EOS 5D Mark Il, EOS 7D, EOS 50D, EOS 550D and Basic
EOS 500D. For images shot with the camera’s Auto Lighting Optimizer Operation
* ALO stands for Auto Lighting Optimizer. function, the checkbox is already checked.
Select the [NR/Lens/ALO] tab sheet from the tool Change the settings according to your preferences. gg‘é?;‘t‘i:gg
palette in the edit window or edit image window. _RAW__RGB | NR/Lens/ALO }
RAW | RGE || NRJLens/ALO H ‘Autn Lighting Optimizer ‘
: Advapced
[Pt i Dtz | & B Select from three levels: "::3%5:;9
™ —e— Low/Standard/Strong
e Bl L Auto correction is applied to the image to match the settings. Processing
\"""“ il T — \ For images shot with the camera’s Auto Lighting Optimizer Large Numbers
RAW (N Breview ) function, the settings at the time of shooting are applied as the of Images
Luminamce noise reduction defaUIt values.
@ p T To cancel the Auto Lighting Optimizer, remove the check mark JIESCI;II%%F
Chrominance noise reduction
- ; " from the checkbox. Images
TIFF/JPEG
Luminance noise reduction Reference
10 o=y 20
Chrominance noise reduction
10) 1) 20
Lens aberration correction — Tune... ‘ Index
Peripheral illumination B3
Distorticn OFF
Chromatic aberration OFF
Color blur OFF
(D) When [Highlight tone priority] is set to [Enable] in EOS 7D and EOS

550D Custom Functions, the Auto Lighting Optimizer function

cannot be set.
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Reducing Noise

You can reduce noise that arises in RAW images shot at night or with a

high ISO speed.

NR is an abbreviation for “noise reduction”.

Select the [NR/Lens/ALO] tab sheet from the tool
palette in the edit window or edit image window.

Click the [NR Preview] button.

|Noise reduction Apply
RAW [[ MR Preview... |

The [NR Preview] window appears.

Adjust an image.

8NN

K

NR Preview

{0

{00

Luminance noise reducty

Chrominance noise redygay

Navigator
window

— Enlargement
display
position

Drag the
sliders

- Cancel

D | |

|
NR check window

You can set a noise reduction level from within a range of 0 to 20.
The larger the setting, the larger the noise reduction effect.

The noise reduction effect can be checked when an image is
displayed at 100% in the NR check window.
You can change the display position of the NR check window by
dragging the enlargement display position in the navigator

window.

Click the [Apply] button.

Noise reduction is applied to the image and the image is
redisplayed.

? The noise reduction function does not work

Noise reduction cannot be applied when [Viewing and saving RAW
images] (p.73) is set to [High speed] in the [Preferences] window.
Select [High quality] to reduce noise.

¥
=)= To set the same noise reduction level for several images

After selecting multiple images in the main window, you can set the
same noise reduction level for the images without displaying the [NR
Preview] window, by adjusting the noise reduction level in the [NR/Lens/
ALQ] tool palette (p.112) using the [Luminance noise reduction] and
[Chrominance noise reduction] sliders, and then clicking the [Apply]
button.

@ You can set the default noise reduction beforehand, using
[Default noise reduction settings] in the [Tool palette] tab sheet in
the [Preferences] (p.76).

* When [Apply camera settings] is selected, you can pre-set a
noise reduction level that suits the camera settings beforehand
as the default.

* When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand. This is
particularly useful for applying noise reduction to all the images
in a folder at once, such as batch noise reduction for images
with high ISO speeds.

However, for images with recipes attached, the noise level

recorded in the recipe will be applied.

If [Luminance noise] has been set, resolution may be reduced

along with reduction of noise.

If [Chrominance noise] has been set, color bleeding may occur

along with reduction of noise.

For a list of [NR Preview] window functions, refer to p.113.
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Correcting Lens Aberration

You can easily make corrections to drops in peripheral illumination,
distortions in the subject, and color blur which occur by the physical
characteristics of the lens or slightly remaining aberration.

Please note that you can only correct RAW images which have been
taken with the compatible cameras and lenses listed below. JPEG or
TIFF images cannot be corrected.

Compatible Cameras

EOS-1D Mark IV EOS-1Ds Mark Il EOS-1D Mark Il
EOS-1D Mark II N EOS-1Ds Mark Il EOS-1D Mark Il
EOS-1Ds EOS-1D EOS 5D Mark I
EOS 5D*1 EOS 7D EOS 50D

EOS 40D EOS 30D*2 EOS 550D

EOS 500D EOS 450D EOS 400D DIGITAL
EOS 1000D — —

*1 Requires firmware version 1.1.1
*2 Requires firmware version 1.0.6

Compatible Lenses

Ultra wide and wide lenses

EF 14mm f/2.8L USM

EF 20mm /2.8 USM

EF 24mm f/1.4L Il USM*3
EF 28mm /1.8 USM

EF 35mm f/1.4L USM

EF 14mm f/2.8L Il USM*3
EF 24mm f/1.4L USM

EF 24mm /2.8

EF 28mm /2.8

EF 35mm f/2

Standard and medium telephoto lenses

EF 50mm f/1.2L USM*4
EF 50mm /1.8

EF 85mm f/1.2L USM
EF 85mm /1.8 USM

EF 50mm /1.4 USM

EF 50mm /1.8 Il

EF 85mm f/1.2L Il USM*>
EF 100mm f/2 USM

Telephoto lenses

EF 135mm /2L USM

EF 200mm f/2L IS USM*3
EF 200mm /2.8L 1l USM
EF 300mm f/4L IS USM

EF 400mm /5.6L USM

EF 500mm f/4L IS USM

EF 800mm f/5.6L IS USM*3

EF 135mm /2.8
(with Softfocus mechanism)

EF 200mm f/2.8L USM
EF 300mm f/2.8L IS USM
EF 400mm /2.8L IS USM
EF 400mm /4 DO IS USM
EF 600mm f/4L IS USM
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Zoom lenses

EF 16-35mm f/2.8L USM

EF 17-35mm f/2.8L USM

EF 20-35mm /3.5-4.5 USM

EF 24-85mm /3.5-4.5 USM

EF 28-70mm f/2.8L USM

EF 28-90mm f/4-5.6 1l USM

EF 28-90mm f/4-5.6 Il

EF 28-105mm /3.5-4.5 USM
EF 28-105mm /4-5.6 USM

EF 28-135mm /3.5-5.6 IS USM
EF 28-200mm f/3.5-5.6 USM
EF 55-200mm f/4.5-5.6 1| USM
EF 70-200mm /2.8L USM

EF 70-200mm f/2.8L IS 1l USM*3
EF 70-200mm f/4L IS USM*4

EF 16-35mm f/2.8L Il USM*3
EF 17-40mm f/4L USM

EF 24-70mm f/2.8L USM

EF 24-105mm f/4L IS USM

EF 28-90mm f/4-5.6 USM

EF 28-90mm f/4-5.6

EF 28-90mm f/4-5.6 Il

EF 28-105mm /3.5-4.5 1| USM
EF 28-105mm f/4-5.6

EF 28-200mm /3.5-5.6

EF 28-300mm f/3.5-5.6L IS USM
EF 55-200mm f/4-5.6 USM

EF 70-200mm /2.8L IS USM
EF 70-200mm f/4L USM

EF 70-300mm /4-5.6 IS USM

EF 70-300mm f/4.5-5.6 DO IS USM EF 75-300mm f/4-5.6 11*3

EF 75-300mm f/4-5.6 111*3

EF 75-300mm f/4-5.6 Il USM
EF 90-300mm f/4.5-5.6

EF 100-300mm f/4.5-5.6 USM

EF 75-300mm f/4-5.6 USM

EF 75-300mm f/4-5.6 [l USM

EF 90-300mm f/4.5-5.6 USM

EF 100-400mm /4.5-5.6L IS USM

Macro lenses
EF 50mm f/2.5 Compact Macro*3 EF 100mm f/2.8 Macro USM
EF 100mm f/2.8L Macro IS USM*3 EF 180mm f/3.5L Macro USM

MP-E 65mm /2.8 1-5x Macro
Photo*3

EF-S lenses
EF-S 60mm f/2.8 Macro USM EF-S 10-22mm f/3.5-4.5 USM
EF-S 15-85mm f/3.5-5.6 IS*3 EF-S 17-55mm /2.8 IS USM
EF-S 17-85mm f/4-5.6 IS USM  EF-S 18-55mm /3.5-5.6
EF-S 18-55mm /3.5-5.6 |l EF-S 18-55mm f/3.5-5.6 USM
EF-S 18-55mm f/3.5-5.6 Il USM  EF-S 18-55mm f/3.5-5.6 IS*3
EF-S 18-135mm f/3.5-5.6 1S*3 EF-S 18-200mm f/3.5-5.6 1S*3
EF-S 55-250mm f/4-5.6 1S*3 —

Aberration correction will not apply to images shot with a combination
of lenses *3*4 *5 and EOS 5D or EOS 30D with the firmware versions
below.

* You cannot attach an EF-S lens to EOS 5D.

*3 EQS 5D with firmware version 1.1.0 or earlier, EOS 30D with
firmware version 1.0.5 or earlier

*4 EOS 5D with firmware version 1.1.0 or earlier, EOS 30D with
firmware version 1.0.4 or earlier

*5 EOS 5D with firmware version 1.0.5 or earlier, EOS 30D with
firmware version 1.0.4 or earlier

You can also correct RAW images taken with the compatible lens
even when the extender is attached.

You can also correct RAW images shot with EF 50mm /2.5
Compact Macro fitted with Life Size Converter EF.

The aberration correction function is not available for images shot
with combinations of camera/lens other than those given under
“Compatible Cameras” and “Compatible Lenses”. They are
therefore not displayed and cannot be used.
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Making Corrections

You can make corrections to any of the four aberrations as below, either
one at a time or simultaneously.
Peripheral illumination
Distortions
Chromatic aberration (color fringing which occurs in the periphery of
an image)
Color blur (blue or red color blur which sometimes occurs at the edge
of the highlighted area of an image)

In the tool palette, select the [NR/Lens/ALO] tab
sheet.

Click the [Tune] button.

" RAW RGB | NR/Lens/AlO }———
|Autc| Lighting Optimizer |
E 1 1
Low Standard  5trong
| Moise reduction Apply |
RAW | MR Preview... |

Luminance noise reduction

{2J D rrrrrrrrrrrrrreninrn 20

Chrominance noise reduction

{SJ D trrirrrrnirnineeninng 20

TIFF/JPEG

Luminance noise reduction

(0 DT —n

Chrominance noise reduction

10) i 20
Lens aberration correction l S J|

Peripheral illumination 63

Distortion QOFF

Chromatic aberration OFF

Color blur OFF

The [Lens aberration correction] window appears.

Checkmark the items to be corrected.

ns aberration correction - [IMG_1001.CR2]

The image is corrected and redisplayed.

Check the results of corrections to peripheral illumination or
distortions in the full view.

Check the results of corrections to chromatic aberration and color
blur by clicking the area on the image you want to check. In the
top right of the window, the area is displayed at 200% in the
enlargement display section (p.118).

You can lessen the degree of correction by moving the slider to
the left for the item you want to correct.

You can respectively correct red chromatic aberration with the [R]
slider of the [Chromatic aberration] or blue chromatic aberration
with the [B] slider.

Click the [OK] button.

The [Lens aberration correction] window closes and the result of
the corrections is applied to the image in the edit window and the
image is redisplayed.

The result of the settings of the [Lens aberration correction]
window is also displayed in the tool palette.

In the main window, the [g)'JJ] mark is displayed on the image to
indicate the lens aberration corrections (p.109).
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About Shooting Distance Information Slider

When correcting RAW images shot with the cameras in the table below,
if shooting distance information has been saved to the image, the slider
is set automatically according to this shooting distance information.
However, if no shooting distance information is saved to the image, the
slider is set automatically to the right end at infinity position and a [<!>]
appears above the slider.

If the image’s shooting distance is not infinite, you can minutely adjust
the distance by operating the slider while looking at the screen.

EOS-1D Mark IV EOS-1Ds Mark Il EOS-1D Mark Il
EOS 5D Mark I EOS 7D EOS 50D

EOS 40D EOS 550D EOS 500D

EOS 450D EOS 1000D —

When correcting RAW images shot with the cameras in the table
below, it is set automatically to the right end at infinity position. You
can then minutely adjust the distance by operating the slider while
looking at the screen if the shooting distance is not infinite.

EOS-1D Mark II N EOS-1Ds Mark Il EOS-1D Mark I
EOS-1Ds EOS-1D EOS 5D
EOS 30D EOS 400D DIGITAL —

For RAW images shot with MP-E 65mm /2.8 1-5x Macro Photo or EF
50mm /2.5 Compact Macro with Life Size Converter EF, the slider
indicator changes to [Magnification factor].

[Shooting distance information] slider is applied to all the correction
items with check marks.

Correcting Multiple Images at a Time

Select multiple images to correct in the main window. Display tool
palette by clicking the [Tool] button (p.107) in the toolbar. If you perform
correction procedures (p.62) when tool palette is displayed, you can
apply the same corrections to all the images selected in the main
window.

Also, you can apply same corrections by copying the recipe of the
corrected image and pasting it onto the multiple images (p.38).

? Additional information

Some noise appeared in the periphery of an image after
correcting [Peripheral illumination]

You can reduce the noise by using luminance and/or chromatic noise
reduction of the noise reduction function (p.59). However, if you had
applied high amount of [Peripheral illumination] correction to the
images that have been shot at night or with a high ISO speed, the
noise might not be reduced.

The image appears with less resolution after correcting
[Distortion]

You can make the image similar to the one before correction by
applying more sharpness with the sharpness adjusting function
(p-29).

The colors of the image became weaker after correcting [Color
blur]

You can make the image similar to the one before correction by

adjusting the color tone (p.27) and/or the color saturation (p.91) to
make the color deeper.

The result of [Color blur] correction cannot be detected
[Color blur] correction is effective for correcting blue or red color blur

which occurs at the edge of the highlighted area of an image. If
conditions do not match, correction cannot be made.

® The periphery of the image may be truncated when [Distortion]

correction is made.

@ For a list of the [Lens aberration correction] window functions, refer

to p.118.
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Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images shot with the camera

that can attach this data, can be used to automatically erase dust spots.

Compatible Cameras

EOS-1D Mark IV EOS-1Ds Mark 11l EOS-1D Mark Il
EOS 5D Mark Il EOS 7D EOS 50D

EOS 40D EOS 550D EOS 500D

EOS 450D EOS 400D DIGITAL EOS 1000D

In the main window, select an image appended with
Dust Delete Data.

Select the [Tools] menu » [Start Stamp tool].
The copy stamp window appears.

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

lels) (%1 1/2 IMG_0050.CR2 [3456 x 23

Dust spots are erased in a single operatlon

Click the [OK] button to return to the main window.
The [3] mark (p.109) is displayed on an image from which dust
spots have been erased.
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? Additional information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.40).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.66) or the copy stamp function (p.68).
The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.39).

¥

~
-

< Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

ﬁl For a list of the copy stamp window functions, refer to p.119.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].
Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one.

In the main window, select the image you want to
erase dust spots.

Select the [Tools] menu » [Start Stamp tool].
The copy stamp window appears.

When the image has redrawn itself, double-click the
point from where dust is to be erased.

et t0 100% View to perform stamp operation. Z

The display changes to 100% view.
The display position can be changed by dragging.

Click the button that matches the dust spot to be
erased.
If the dust spot is dark in color, click the [ @ |] button, and if
the dust spot is light in color, click the [ ( »( > |] button.
When you move the cursor over the image, the dust erasure
range appears as [O].

Place the dust spot to be erased within the [O] and
click.

806 (¥ 1/1 IMG_0050.CR2 [3456 x 2304]

Click

-

Circe the dark spot o repar

The dust spot within the [Q] is erased.

Click on another part of the image to continue erasing dust spots
in the image.

To erase dust in another part of the image, click the button
clicked in step 4 again to cancel dust erasure processing and
perform the operation again from step 3.

When the dust spot cannot be erased, [(§)] is displayed.

Click the [OK] button to return to the main window.
The [@,] mark (p.109) is displayed on an image from which dust
spots have been erased.
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.68).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.40).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.39).

¥

== Useful functions of the copy stamp window

Checking the dust erased spots

After step 5, you can display and check in detail the erased dust spots

one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 5, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the

erased dust spot displayed.

Switch between full screen display/normal screen display using

shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then

displaying the other image to which you want to apply the results and

clicking the [Paste] button.

To apply dust erasure to the same place in several other images, you

can efficiently erase dust spots by clicking the images while holding
down the <38> key in the main window, or, by selecting multiple
images by clicking the first image and then clicking the last image
while holding down the <shift> key, and then displaying the copy
stamp window.

@ For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.

@ For a list of the copy stamp window functions, refer to p.119.
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Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1 to 3 in “Manually Erasing Dust (Repair
Function)” (p.66).

Specify the section to be copied.
Click on the section that is to be the copy source while holding
down the <option> key.
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy
Source position].

Correct the image.
Click or drag on the section you want to correct on the image. [+]
in the window indicates the copy source and [Q] indicates the
copy destination.
The copied image is pasted in the position to which it was
dragged.
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Click the [OK] button to return to the main window.
The [@,] mark (p.109) is displayed on a corrected image.

Transferring a RAW Image to Photoshop

A RAW image can be converted to a TIFF image (16bit) and transferred
to Photoshop.

Select the [Tools] menu P [Transfer to Photoshop].
Photoshop starts up and the transferred image is displayed.

? A single image can be transferred at a time

Only one image can be transferred at a time. To send multiple images at
a time, refer to p.84.

@ Compatible versions of Photoshop are CS or later.
Transferred images are automatically converted to TIFF images
(16bit) to which an ICC profile (p.122) is added. The ICC profile
contains information about [Preferences] (p.77) or work color
space set for each image as described below and the appropriate
color information is relayed to Photoshop.
When you quit Photoshop, only the original RAW image remains,
and the transferred image will disappear. Saving the transferred

image as a separate image in Photoshop is highly recommended.

Setting Work Color Space

A different work color space (p.123) from the default settings (p.77) can
be set for each image.

Select the [Adjustment] menu » [Work color space] »
color space to be set.

? A color space set individually does not change even when the
default setting is changed

If you set an image with a color space different to the default setting and
then subsequently change the default color space setting (p.77), this
default setting will not be applied and the individually set color space will
remain.

-Z@/E The color space of a RAW image can be changed freely as
many times as required

Since only the image processing conditions information changes, the
color space of a RAW image can be changed at any time.
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Printing with Shooting Information

You can freely lay out one image on one sheet of paper and print
together with titles and shooting information, etc.

Select one image to be printed.
Select the [File] menu » [Print with detailed setting].
Specify the required settings for printing, and then

click the [Print] button.
Switches the settings tab sheet

# IMG_0001.CR2

(J Printer | Image = Text Settings )

Printer :

Properties

Media
A4

Media orientation

(_J Portrait

(O] Landscape

Media size:
297.0 mm x 209.9 mm

Print profile:

CMYK profile:

o= ETm

Print preview

The image can be moved by dragging.

Drag the four corners of the image to change the size.

For the shooting information, click [E]] on the [Text] tab sheet
and select the necessary items in the window that is displayed.

5@/3 To maintain the settings

The settings of each tab sheet in step 3 are memorized when the [Apply]
button is clicked (excluding the contents of the [Text] tab sheet). The
settings can be applied to another image when printing.

@ You can set printer profiles (p.77).

If CMYK simulation has been set, the image is printed in the set
colors (p.77).
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Printing a Thumbnail List (Contact Sheet Printing)

You can print rows of multiple images on one sheet of paper.

Select images to be printed in a thumbnail list.
Select the [File] menu » [Contact Sheet Prints].

Specify the required settings for printing, and then
click the [Print] button.
Switches the settings tab sheet

Contact Sheet Prints

L Printer | Image | Text | Settings f

Printer .

Properties
Media :

A4

Media orientation:

) portrait
C Landscape
Media size:

209.9 mm x 297.0 mm
Print profile:

CMYK profile:

CMS settings...

( Apply )( Cancel I( Print )

Print preview

@ To maintain the settings

The settings of each tab sheet in step 3 are memorized when the [Apply]
button is clicked (excluding the contents of the [Text] tab sheet). The
settings can be applied to another image when printing.

@ You can set printer profiles (p.77).
If CMYK simulation has been set, the image is printed in the set
colors (p.77).
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Printing RAW Images on a High-End Canon Printer

Printing with a High-End Canon Inkjet Printer

For high-end Canon inkjet printers that are compatible with the printing
software Easy-PhotoPrint Pro, you can print with DPP by a simple
operation that has the following features:

Simple printing of RAW images

Printing in faithful colors

High quality printing using a wide color space of Adobe RGB, etc. and

the wide color reproduction range of a high-end Canon inkjet printer

To print with DPP, first install Easy-PhotoPrint Pro version 1.3 or later on
your computer.

Select the [File] menu » [Plug-in printing] » [Print
with Easy-PhotoPrint Pro].
Easy-PhotoPrint Pro starts up.

Match on-screen image colors and printing result

colors.
Select [Custom] in [Print Quality], click the [Set] button, and in the
window that appears, drag the slider to [1] at the right end, and
then click the [OK] button to close the window.
Next, click the [Color Adjustment] button to display the [Color
Adjustment] window and display the [Color Management] tab
sheet. Set [Color Mode] to [Enable ICC Profile] and [Printer
Profile] to [Auto], and then click the [OK] button to close the
[Color Adjustment] window.

Specify any other required settings for printing, and

then print.

? Additional information

Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
Function set in DPP that is not applied to printing

Specified CMYK simulation (p.77) is not applied.

The printed image’s color is not what you expected

In the Easy-PhotoPrint Pro window, click the [Color Adjustment]
button to display the [Color Management] tab sheet, set [Rendering
Intent] to [Perceptual] (p.123), and try printing.

Ay

-@> Advantages of printing with Easy-PhotoPrint Pro

Printing with faithful colors

When a color space is set (p.68, p.77), it is automatically transmitted
from DPP to Easy-PhotoPrint Pro, allowing you to print with faithful
colors.

Printing with a wide color reproduction

When the color space setting (p.68, p.77) is set to a color space wider
than sRGB (such as Adobe RGB), the image is printed with a wider
color gamut than an image that has an sRGB color space, with green
and blue in particular being reproduced vividly.
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Printing with a Large-Format Canon Printer

You can use DPP to print with the DPP-compatible Canon large-format
imagePROGRAF printer. To print with DPP, first install imagePROGRAF
Print Plug-In for Digital Photo Professional on your computer.

Select the [File] menu » [Plug-in printing] » Plug-In
for the printer you use.
The Plug-In starts up.

Specify the required settings for photograph
printing, and then print.

? Additional information

A single image can be printed at a time

You can print a single image selected in DPP at a time. When printing
multiple images, perform printing for each image individually.
Functions set in DPP that are not applied to printing

Specified output resolution (p.73) and CMYK simulation (p.77) are not
applied.

/

== Advantages of printing with inagePROGRAF Print Plug-In

Printing with faithful colors
When a color space is set (p.68, p.77), it is automatically transmitted
from DPP to the Plug-In, allowing you to print with faithful colors.

Printing with a wide color reproduction

When the color space setting (p.68, p.77) is set to a color space wider
than sRGB (such as Adobe RGB), the color reproduction range of the
imagePROGRAF printer is fully utilized and the image is printed with
a wider color gamut than an image that has an sRGB color space,
with green and blue in particular being reproduced vividly.
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Specifying Preferences .
Introduction
You can change the various functions of DPP in the [Preferences] -
window. Check the contents of each window and set. General Settmgs
Also, depending on the item, a detailed explanation may be available, You can specify the folder that opens when DPP is started up, image
so refer to each window. quality of displayed and saved RAW images, etc. cg’gfanl:zeat
Select the [Digital Photo Professional] menu » [ Preferences )
Basic
[Pl'eferenCES]. . 4{ General settings | View settings Tool palette Color management ——— 0peration
The [Preferences] window appears.
Startup folder
Select the tab sheet, specify the settings, and then B ot amsion i Aq )
click the [OK] button. O specified folder pence
- [ ] ~ Browse.. MacOSX /Users/canon (Desktop operatlon
Preferences
Save recipe
48 General settings | View settings Tool palette Color management )7 ) Display message when adding file Ad ced
) Add to file automatically |mag\5ﬂtlng
starte folder Viewing and saving RAW images and nting

{®) Last displayed folder

@ High quality (recommended)

_ Specified folder = e o o )
_ View images at high speed (moiré reduction o H
Browse.. MacOSX /Users /canon/Desktop () High speed View/save RAW images at high quality ProceSSIng
e L) Highisp e Large Numbers
Moiré is reduced and the NR tool palette can be used
Save recipe of Images
{*) Display message when adding file JPEG image guality
() Add to file automatically [_| Remove block noise and mosquito noise A
|| Display thumbnails at high quality Edltlng
Viewing and saving RAW images JPEGI/TIFF
Nt e Default value of output resolution Images
_! Wiew images at high speed (moiré reduction off) 350 dpill-60000)
: High speed View/save RAW images at high quality
Moiré is reduced and the MR tool palette can be used At EOS Util;'!:\;r startup
JPEG image quality | Edit image window enabled at EOS Utility startup Reference
_! Remove block noise and mosquito noise I" = N ) ( = )
ance!
| Display thumbnails at high guality
Default value of output resolution
— . Index
350 dpi(1-60000)

At EOS Utility startup

| Edit image window enabled at EOS Utility startup

( Cancel ) f 0K 3 @ @
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Viewing and saving RAW images

You can select from two types of image quality for displaying/saving
RAW images: high image quality with false color reduction processing
and noise reduction function (p.59) used, or high speed without false
color processing and noise reduction function used.

[High quality]
False color reduction processing is automatically applied, and the
image can be displayed/saved as a false color reduced-high quality
image. Furthermore, you can use the noise reduction function (p.59)
to reduce the luminance noise and chrominance noise.
Because the effects of the false color reduction processing and noise
reduction function are difficult to see in the [50% view] or [Fit to
window] display of the edit window and edit image window, use
[100% view] or [200% view] to check.
We recommend that you normally set [High quality] for a balance
between image quality and display speed.

[View images at high speed (moiré reduction off)] of [High quality]
If you checkmark [View images at high speed (moiré reduction off)],
when the image is displayed in the edit window or the edit image
window, false color reduction processing is not applied. However, you
can use the noise reduction function.

As the setting is the same as [High quality] other than for image
display, the image undergoes false color reduction processing when it
is saved.

[High speed]
Since false color reduction processing is not applied, the display
speed of a RAW image in the edit window or the edit image window,
and the time it takes to save a RAW image is shorter than with [High
quality].
You cannot use the noise reduction function (p.59).
Depending on the image, it may be displayed/saved with false color
or noise being noticeable.

® For images shot with ISO speed range expansion set, the difference
in image quality between [High quality] and [High speed] becomes
remarkable. To check the image quality of images shot with ISO
speed range expansion, make sure to set [High quality] and check
the images in the edit window or edit image window.

JPEG image quality

[Remove block noise and mosquito noise]
You can improve the quality of a JPEG image by reducing the noise
particular to JPEG images.
This setting is also effective when RAW images are converted to
JPEG images and saved (p.39, p.83) and for JPEG images that have
been saved with a different name.

[Display thumbnails at high quality]
You can have the thumbnails for JPEG images automatically displayed
at high quality. If you checkmark [Display thumbnails at high quality],
all subsequent JPEG image thumbnails imported into DPP will be
displayed at high quality.

? The extent of the improvement in noise reduction

The higher the JPEG image’s compression rate, the more noise is
reduced. When the compression rate is low, the effect of noise reduction
is negligible.

Default value of output resolution

You can set the resolution for RAW images converted and saved as
JPEG or TIFF images (p.39, p.83).
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View Settings

You can specify settings relating to the display.

Preferences

General settings | View settings | Tool palette Color management

Grid pitch

64 Pixels(8-256)

Locking selected image

E Images opened in Edit window remain selected in main window

Magnification in Edit window

® Fit to window O s0% ) 100% O 200%

Magnification when the Edit/Edit image window is double-clicked

® 50% ) 100% () 200%

RAW and JPEG

a Display only CR2 images for CR2 and JPEG files of the same name

Sort order in main window

# Retain sort order

Highlight/shadow warning

Highlight 255 (192-255) I
Shadow o (0-64) ]

Quick check tool display

® s0% ) 100% (moiré reduction off)

( Cancel ) 6 oK

Sort order in main window

You can set the order of images which have been rearranged in the
main window to be maintained or not maintained (p.19).

If you checkmark the checkbox, the order of the rearranged images is
maintained even if you quit DPP or select another folder in the folder
area.

If you remove the check mark, the order of the rearranged images is not
maintained and reverts to the previous order when you quit DPP or
select another folder in the folder area.

Highlight/shadow warning

Highlighted/shaded areas that exceed the set range can be displayed
on the image as warning indicators (p.52).
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Tool Palette

You can specify settings for the tool palette.

‘ Y
Preferences

- General settings View settings | Tool palette | Color management -

Default settings of RGB Tone curve mode

Tone curve mode Tone curve interpolation method Histogram
) RGERGE # Curve

) Luminance R G B () Straight

) Before adjustment
#) After adjustment

Tool palette display in Edit Image Window
®) Docking display
) Floating display

Modified Picture Style settings
E Retain settings of each Picture Style

Tool palette display mode

|| Same for Main window and Edit window

Default noise reduction settings

@ Apply camera settings

) Set as defaults

RAW luminance noise reduction: {0

RAW chrominance noise reduction: o £

TIFF/JPEG luminance noise reduction: (2] e T

TIFF{JPEG chrominance noise reduction: {0)

|'_ Cancel ) f 0K ’

Default settings of RGB Tone curve mode

You cannot apply changes to the settings until you re-open the folder.

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

Modified Picture Style settings

You can select whether the [Color tone], [Color saturation], [Contrast]
and [Sharpness] settings will be changed or retained, when you change
the Picture Style.
If you checkmark the checkbox, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be changed to match the
camera’s preset settings, when you change the Picture Style.
If you remove the check mark, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be retained, even if you
change the Picture Style.

Default noise reduction settings

You can set a default beforehand for the noise reduction level.
RAW Images
* When [Apply camera settings] is selected, you can pre-set a noise
reduction level that suits the camera settings beforehand as the
default.
* When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand.
JPEG/TIFF Images
* You can set a desired default noise reduction level beforehand.
For images not having a recipe attached, the default set here for noise
reduction level is applied. However, if you want to apply settings to
images in the opened folder, you need to re-open the folder after making
settings here. For images with a recipe attached, the noise level
recorded in the recipe remains as it is and the default for noise reduction
level set here is not applied.

—I@/i- Advantages of setting a noise reduction default

In instances where the same level of noise occurs in several images,
such as images shot with high ISO speed, setting an appropriate default
noise reduction setting enables you to apply a batch noise reduction
default to all the images displayed in DPP (excluding images with a
recipe attached). This eliminates the need to apply noise reduction to
each individual image. And, since you always shoot with the same
conditions, it is also useful when you want to set the same noise
reduction level for all shot images.
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Color Management

You can specify settings relating to color management, such as settings
for work color space, conditions for color matching, etc.

Preferences

+ General settings View settings Tool palette Culurmanagement}

Default settings of Work color space
) sRGB

— Adobe RGB

" Wide Gamut RGE

_ Apple RGB

") ColorMatch RGR

CMM settings for print
For display
*) sRGB

"~ Monitor profile
ENG /Library/ColorSync/Profiles/Displays/Acer AL1922-1CAB459B4.icc

Printing profile: Rendering intents:

None | t]

CMYK simulation profile; Rendering intents:

None J t!

Rendering intents when using Easy-PhotoPrint
: Perceptual

¥ Relative Colorimetric

Cancel {' 0K 3

Default settings of Work color space

You can select from five types of color space (p.123) that is applied as a
default setting in RAW images. Color space that has been set is applied
as the color space when a RAW image is converted and saved (p.39,
p.83) or printed (p.40, p.43, p.46, p.69 to p.72).
If you have changed the setting, and you restart DPP, the new setting
is applied as the default setting color space.
You can check color space that has been set in an image in the main
window (p.107, p.108), the edit window (p.110), and the edit image
window (p.115).

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

@ You can set a color space that is different from the default settings
for each image (p.68).

Display setting (color setting of the monitor)
Where a profile (p.122) is attached to the monitor you are using, you can
display an image in more faithful colors by setting the profile.

Select the [Monitor profile], click the [Browse] button and in the dialog
box that appears, select a profile for your monitor.

-Z@/E Precise coloring with a third-party monitor color reader

If you use a profile created using a third-party monitor color reader,
images can be displayed in even more precise colors.
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Setting of printing profile (color setting of the printer)

Where a profile (p.122) is attached to the printer you are using to print
images, you can print an image and simulate the colors displayed on
screen by setting the profile. The profile that has been set is applied to
all printing (p.46, p.69, p.70) except for printing using a Canon inkjet
printer (p.40, p.43) or linked printing (p.71, p.72).

? The adjustment function of the printer driver should not be
used

Even if you set a printer profile, if you use the color adjustment function
of the printer driver, the image may print in colors different from those
displayed on screen.

5@/5 Automatic settings for printing using EPP EX, EPP, and
linked printing

If you are printing using a Canon inkjet printer (p.40, p.43) or using
linked printing (p.71, p.72), a profile is set automatically even when the
[Printing profile] setting is not performed. This allows you to print faithful
colors easily.

Setting of CMYK simulation profile

You can select the color when printing in the CMYK environment of a
printing machine, etc. from four types of profiles (p.123) and perform
simulation on screen.
When CMYK simulation has been set, [CMYK] appears (p.107, p.108,
p.110, p.115) in the bottom of the main window, edit window and edit
image window, and colors can be checked.
To temporarily cancel CMYK simulation, press the <space> key.

Rendering intents when using Easy-PhotoPrint
You can set a rendering intent (matching method) (p.123) for printing
using Easy-PhotoPrint (p.43).

The rendering intent is ordinarily set to [Relative Colorimetric].

When colors with [Relative Colorimetric] are not satisfactory, set to
[Perceptual].
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4 Useful Functions for Processing Large Numbers of RAW Images

For users shooting a large amount of RAW images, the convenient
function of batch processing large amounts of RAW images is explained
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Utilizing Adjustment Contents (Recipe)

All the adjustment contents (recipe) made using the tool palette can be
saved as an individual recipe file (extension “.vrd”) and loaded and

Introduction
? Additional information

applied to another image. Recipe data includes tool palette contents
b - . A : . . . . Contents at
You can edit images efficiently by selecting and adjusting one image Recipe data includes adjustments made with the tool palette ([RAW], a Glance
from images shot with the same shooting environment and batch [RGB] and [NR/Lens/ALQ]). For this reason, other editing content
applying the adjustment results to a large number of images. such as trimming or dust-erasure (copy stamp) is not included in the
R recipe data. Basic
— {:‘““: : :‘CE e Recipes adjusted with the [RAW] tool palette can only be applied Operation
| rightness adjustmen 3" to RAW images
it : o o Adjustments in the [RAW] tool palette, which can only be made for
| S (0] RAW images, are not applied to a JPEG or TIFF image even if they deanged
[#] TR peration
( Sh.ol settings . . -¢]" Tune... ‘ are paSted
Picture Style bn ‘ Advanced
Standard -‘]'/ Browse... | Image Editing
— =ttt and Printing
Procefsing
— Larg bers
J10.0 80 -60 40 -20 0 20 4.0 g of Im ges
aitas g o
oo : . Contents adjusted using the tool J,fé'c';t,'}‘ﬁ:,:
e R palette can be handled Images
Coorine: = individually as a recicpe file
Color saturation: -——13-—-—- (eXtenS|on “.Vrd”).
%[Earpness: '—‘\:/'r— Reference
Index
|§| The adjustment contents of JPEG or TIFF images (p.87) can be @

saved as a recipe file (extension “.vrd”) and loaded and applied to

another image in the same way as with RAW images. 80



Introduction

Saving Recipes as a File

Select an edited image, and then select the [Edit]

Copying a Recipe and Applying to Another Image

You can copy a recipe of an edited image and then apply it to another
image. Contents at

menu » [Save recipe in file].
The [Save] dialog box appears.

Select the destination folder, enter a file name, and

and then select the [Edit] menu » [Copy recipe to Basic
then click the [Save] button. clipboard]. Operation
The recipe is copied.
? Check the contents of a recipe file by pasting to an image Select the image to Whi_Ch the recipe is to be. applied Sﬂ‘é?:t?gﬂ
o . _ and then select the [Edit] menu » [Paste recipe to
When you do not know the contents of a recipe file, paste it to an image .
L : selected image].

and check the settings in the tool palette. When only a few settings are o _ _ Advanced
adjusted, we recommend you use a file name that describes the The recipe is applied to the image. Image Editing
contents or that you separately record the adjustments as text and Printing

information.

Select the image from which a recipe is to be copied

a Glance

Procefsing
Largbers
of Iméges
Loading and Pasting Recipes -
iting
Select the image to which a recipe is to be applied, J?ESILEF
and then select the [Edit] menu » [Read and paste J
recipe from file].
The [Open] dialog box appears. Reference
Select a recipe and click the [Open] button.
The recipe is applied to the image.
Index
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Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific
shooting environment can be registered as personal white balance. You
can then perform efficient white balance adjustment by applying this
personal white balance to a large number of RAW images shot in the
same shooting environment.

Registering Personal White Balance

Adjust the white balance (p.25, p.26, p.53).
To adjust white balance, select a setting other than [Shot
settings] from the [White balance adjustment] list box (p.25). You
will be unable to register the adjustments if you select [Shot
settings].

In the [RAW] tool palette, click the [Register] button.
The [Register personal white balance] dialog box appears.

Select the button number to be registered from the
list and click the [OK] button.

=, [#| Register personal white balance

Register current setting in personal white balance

Current setting: Click white balance

[_ Custom 1 | :]]

(  cancel )| )

Applying Personal White Balance

In the main window, select the image to which white
balance is to be applied.

Click the [Tools] button on the toolbar.
The tool palette appears.

Click the personal white balance number button that
is to be applied.

[ RAW | RGB  NR/Lens/ALO
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Batch Save as JPEG or TIFF Images (Batch Processing) o
You can batch convert and save edited RAW images to highly versatile In the processing dialog box, click the [Terminate] button.
JPEG or TIFF images.
The images are saved as separate images, so the RAW images remain
unaffected. '? [Save] cannot be performed Contents at
a Glance
. . . . In the [Batch settings] window, you cannot perform [Save] or [Save As]
In the main window, select multiple images to be (p.38, p.102) to edited RAW images.
converted. Basic
N~ . . . . Operation
Click the [Batch process] button on the toolbar :@: To save the developing/editing results for the version you are currently using
(p.107). DPP’s RAW image development processing technology is continually
The [Batch settings] window appears. being improved upon so that you can perform the latest image Sg‘éf_‘:t‘ggg
. . ] ] processing more appropriately.
Specify the required settings, and then click the Meaning that, between two differing versions of DPP, processing results
[Execute] button. may differ very slightly even if with the same RAW image data, or the Advanced
e —— results of significant editing of RAW image data with an attached recipe Image Editing
IMG_0001.CR2 RIELo e ; may be different. and Printing
0005 12 e == When you want to save the developing or editing results of the version
o oo  cEm = you are currently using as it is, it is recommended that you convert and Procedsing
e image qualey 2 10 save images as JPEG image or TIFF images. Larg4|bers
IMG_0008.CR2 Output setting of Im ges
. 2@ skillful batch saving —
Eggggég m:%;;;] : H(‘:}q ) — While saving is being performed, you can continue working in JITE?Q;I:F
- ok aspectras another window
g“;“:‘::[m - Since the saving function operates independently in the background,
string you can continue with an operation in another window such as the Reference
main window or the edit window during the saving process.
o T To convert all images and save, do not select an image in the
B main window
[ If you do not perform step 1 and perform step 2 with no image Index
) Open image using software - : selected in the main window, all the images displayed in the main
f;’m_% window will be converted and saved.
The batch processing dialog box appears and saving begins. ﬁl If you have selected [New file name] in [File name], [Sequence @ @
When all the images are saved, the [Terminate] button appears in number] has to be set.
the batch processing dialog box. By saving as explained on this page, a trimmed image (p.35,
p.95) or dust-erased image (p.64 to p.68, p.98 to p.102) actually

becomes a trimmed image or dust-erased image.

For a list of [Batch settings] window functions, refer to p.120. 83



Batch Transfer Images to Image Editing Software

You can transfer multiple images to image editing software. Unlike
[Transferring a RAW Image to Photoshop] (p.68), you transfer images
that have first been converted and saved as a seperate image, so the
transferred image will not disappear after quitting the destination
software. The software used here as an example is Adobe Photoshop
CS.

In the main window, select multiple images to be
transferred.

Click the [Batch process] button on the toolbar
(p.107).
The [Batch settings] window appears.

Perform settings required for transferring (e.g. file
format).

Click the [Browse] button.

Batch settings

IMG_0001.CRZ Save folder

IMG_0002.CR2 MacOSX/Users jcanon/Documents ( Browse.. )
IMG_0003.CR2
IMG_0004.CR2

File format

IMG_0005.CR2 Kind of file Exif-JPEG i+

IMG_0006.CR2 : e e =
Image quality Y 10

IMG_0007.CR2

IMC_0008.CR2 Output setting

IMG_0009.CR2 P :

IMG_0010.CR2 Qutput resalution 350 dpi ¥ Embed ICC profile

IMG_0011.CR2 Resize setting

IMG_0012.CR2 _ Resize

IMG_0013.CR2 Width Height Unit

IMG_0014.CR2 3456 | x 2304

IMG_0015.CR2 {3456 pixel ) (2304 pixel )

v
File Name

) Current file name
string

E) New file name

String Sequence number

DPP_ T ool " [l Save sequence number
Ex. DPP_0001.IPG, DPP_Q002.JPG

Image transfer settings
# Open image using software

' ___ Browse.. ’ '

Cancel ) (5 Executei)

The [Open] dialog box appears.

Select Photoshop CS.
In the [Open] dialog box, select a Photoshop CS file or an alias
and click the [Open] button.
The [Open] dialog box closes and [Image transfer settings] in the
[Batch settings] window is set to Photoshop CS.

Checkmark [Open image using software].

Image transfer settings

pen image using software

Adobe Photoshop C5 f Browse... |

f Cancel 3 ( Execute }

Click the [Execute] button.
The processing dialog box appears and batch transfer begins.
When the first image has been transferred, Photoshop CS starts
up and transferred images are displayed in transferred order.
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Batch Change the File Name of Images

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].
The rename window appears.

Specify the required settings (p.121) and click the
[Execute] button.

MacOSX /Users /canon/Pictures /Photo / xxxx_xx_xx

File Name Extension

DPP '™} Shooting Date/Time :}' Sequence number j Do not change Ll
Basic Settings Format settings

Sort Sequence number
@ Fit to main window 0001
:. File Name
:, Shooting Date/Time

" Save sequence number

Shooting Date/Time
f ] Meonth Day Year

4J

R

__ Copy & Rename MM-DD-YY

\

MacOSX/Users/canon/Desktop ™ Insert underbar

Original File Modified File Name

IMG_0001.CR2 - DPP_09-13-06_000L.CRZ T
IMG_0001,JPG U DPP_09-13-06_0002.JPG U
IMG_0002.CR2 DPP_09-13-06_0003.CR2

IMG_0002.JPG DPP_09-13-06_0004.JPG

IMG_0003.CR2 DPP_09-13-06_0005.CR2

IMG_0003.JPG — DPP_09-13-06_0006.JPG

IMG_0004.CR2 DPP_09-12-06_0007.CR2

IMG_0004.JPG DPP_09-12-06_0008.JPG

IMG_0005.CR2 DPP_09-13-06_0009.CR2

IMG_0005.JPG DPP_09-13-06_0010.JPG

€ : ) € z )

[ Cancel Execute

Processing begins and the file names are changed.

? Changes cannot be made when the file name is duplicated

If a file name in red text has appeared in [Modified File Name], the file
name has been duplicated. Changes cannot be made if even one file
name has been duplicated. Change the settings so that duplication does
not occur.

® The name of the movie files cannot be changed in DPP.

@ You cannot start up the rename tool from the [Collection] window
(p.33, p.108).
For a list of the rename window functions, refer to p.121.

Changing the File Name of Images in the Order in the Main Window

When you change the order of the images in the main window, you can
change in one operation the names of the files for the images, in the
order they were rearranged.

Change the order of the images in the main window
(p.19).

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].

Select [Fit to main window].

MacO5sx

File Name

DPP :.' Shooting

Basic Settings
Sort

[ f*) Fit to main window ]
__ File Name

;-1 Shooting Date/Time

Specify the required settings (p.121).
To copy an image, checkmark [Copy & Renamel].

Click the [Execute] button.
The file names are changed and the order in the main window is
maintained.
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5 Editing JPEG and TIFF Images

Introduction
2 DPP is software mainly aimed for advanced RAW image editing, but it —
also has JPEG and TIFF image editing functions. Here, the editing and
saving of JPEG and TIFF images are explained. C:rcl;tfanr:(s:eat
Editing JPEG and TIFF Images.........cccccccevviin. 87 B
About the RGB Tool Palette .........ccccooevveveiiiiiiinnnnnnn... 87 Operation
Automatically Adjusting Brightness and Color (Tone —
Curve AsSiSt) ........cceciiiiiii 88 Advanced
Adjusting Brightness and Contrast ............c.c..ccco....... 89 REFTatEg
Adjusting Color Tone Using Click White Balance....... 90
. . . Ad d
Adjusting Hue, Saturation and Sharpness.................. 91 Imag‘éaggi?ing
Tone Curve Adjustment...........ocoeveeeeeeeeeeeeeeeeeee. Q2 |(@ndizinting
Adjusting Dynamic Range ..........ccccccccoeeveciivrvineennnn... 93 Processing
Reducing NOISE .......c.cceeeeeeeieeeeee e, ST e

Trimming and Adjusting the Angle of an Image....... 95

Performing Automatic Dust Erasure Processing ..... 98 J,flﬁ,%,:
Compatible Cameras............c..cccoeeecvveeeeeeeeeeeenenn. 08 Im#Ges
Automatic Dust Erasure Processing in the Main
WINAOW ..., 99 Reference

Manually Erasing Dust (Repair Function).............. 100 S
Erasing Unwanted Parts of an Image (Copy Stamp
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Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as
RAW images using the [RGB] and [NR/Lens/ALQ] tool palettes.
Because adjustment made with the tool palette (recipe) only changes
the image processing conditions, the “original image data itself” remains
unaffected. Therefore, there are no problems with image deterioration
that arise with editing and you can readjust your images any number of
times.

000 [¥ IMG_0015JPC
RAW |RGB| NR/Lens/ALO

Tone curve assist I
| [0 ) [T ]

Tone curve adjustment
wee R |G| ¢ |
=

255

Yl

|

N

" JPEG, TIFF image data

by | —\

ol B

= [vrd )

Brightness: T 0l —

Contents adjusted using the tool
palette can be handled
individually as a recicpe file
(extension “.vrd”) (p.80, p.103).

Hue:
Saturation:

Sharpness:

In DPP all the adjustments (image processing conditions information)
made with the tool palette can be saved in the image as data called a
“recipe” (p.102), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.vrd”) (p.80, p.103).

About the RGB Tool Palette

With the functions in the [RGB] tool palette, you can adjust JPEG and
TIFF images with the same functions as ordinary image editing
software.

However, because the adjustment width of the adjustment functions in
the [RGB] tool palette is wider than the [RAW] tool palette, the image
color may be saturated, or the image quality may deteriorate if you
adjust too much. Therefore, take care not to adjust your images to an
excessive degree.

You can adjust RAW images with the functions in the [RGB] tool palette.

However, for functions other than tone curve adjustment (p.92) and
automatic adjustment (p.88), we recommend adjusting RAW images
using the same functions available in the [RAW] tool palette.
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.122). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click the desired automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most
images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.

RAW | RGB | NR/Lens/ALO
[T ' 0 [+ Jizs [ Reverts the tone curve
Tone curve adjustment =3 to the original settings
e k| o | e [~
o] « [c ¢ z
255 High
Standard
D 1
0 255
Brightness: 1] i
Contrast: ?
Hue IR RN RS IR AR NE] |'r'b-—‘: I:l E
Saturation: I:_'_ﬁJi 100 i
Sharpness: Ibli o]

The tone curve changes as adjusted.

¥

=@< Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

» Images which have been shot with the proper exposure

» Images where the brightness is unbalanced

* Images which are too dark

» Images which have extreme backlighting

@ If you click the [] button, the tone curve as well as the [Hue]

and [Saturation] revert to the default settings. Take care when
adjusting the [Hue] and [Saturation] individually (p.91).
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Introduction
Adjusting Brightness and Contrast Brightness: Mgve the slider to the right to makg an image
brighter and to the left to make an image darker.
The brightness and contrast of an image can be adjusted. Contrast:  Used to adjust modulation and degree of contrast Contents at
of color. Move the slider to the right to make a Glance

contrast of an image stronger and to the left to

[Tone curve assist 0 [+ 2] make contrast weaker.
Tone curve adjustment - ||

RGE™ R [ c | s |

255

RAW | RGB | NR/Lens/ALO

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Drag the sliders left or

0 255 | . E
. = fght JPEGILF
Brightness: 0= | es

Contrast: g-—l Enter numerical values

Hue:

Saturation: Reference

Sharpness:

@ The adjustment range is —100 to +100 (in 1-stop increments when
entering a value).



Introduction
Adjusting Color Tone Using Click White Balance Click on a point that is to be the standard for white.
0o [* Digital Photo Professional - [ MacOSX/Users fcanon Pictures {Photo / xocxx_xx_xx/IMG_0010.JPG |
You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white Contents at
. . L ) . a Glance
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.
. Basic
Click the [[~]] button. Operation
[ RAW [RGB | NR/Lens/ALO
|Tnne curve assist [ H [ H Eb| Advanced
Tone curve adjustment E=0 Operation
_
PRCE ¢ [ ||
—
Advanced
Image Editing
and Printing
S —
(1167, 5‘7”‘ 216, 222, 233 High quality 'RAW / Adobe RGB CM‘IK%
. " . Processing
The coordinates of the cursor position and the RGB values (8-bit Large Numbers
conversion) of Images
—_—

The color of the image is adjusted with the point you selected as E g
the standard for white. Jplﬁ":,:
|

If you click on another point in the image, the white balance is es
. adjusted again.
: To finish click white balance, click the [|#|] button again.
0 zis‘ [] 9 Reference
Brightness: T 0.
Contrast: T e SR ug
Hue: r—(o] 0[] ? When there are no white areas in your image Index
aturation: b T
okl U — =t When there are no white areas in your image, you can adjust the white
Sharpness: Q—”””””“““““ EJ 0 ‘E‘

balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

ﬁl The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.
The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any
adjustments (p.76).

O
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Introduction
. - . Hue: Move the slider to the right to make color tones
Adjusting Hue, Saturation and Sharpness 9
more yellow, and to the left to make color tones
You can adjust hue (tone) and saturation and make the overall redder.
atmosphere of an image harder or softer : : ; Contents at
p g . Saturation: Move the slider to the right to make the color a Glance
deeper, and to the left to make the color weaker.
RAW | RGB | NR/Lens/ALO Sharpness: Move the slider to the right to make an image
[Tonecorve s (0] o) harder, and to the left to make an image softer. o Bearz;fon
Tone curve adjustment =T B
R R [ c | s | @
2551 ' Advanced
Operation
Advanced
Image Editing
and Printing
Processing
Large Numbers
of Images
0 e | E g
b et JP IFF
s | es
E“ghtﬂ!ss e rEreerrr ey D l:ﬂ
cuntrasr frrerrnr v Dz
Hie: —r@—(oll o [;H Reference
Saturation: — (o) 100 :—} Enter numerical values
Sharpness: @—l | - z_

Index

Drag the sliders left or right 2> Sharpness is unnatural

Adjust sharpness with the window view set to [100% view], [50% view]

or [200% view]. If the view is set to [Fit to window] (full view), the @ @

sharpness will seem unnatural.

|§| The adjustment range is —30 to 30 for hue, 0 to 200 for saturation, @
and 0 to 500 for sharpness (in 1-stop increments when entering a

value).
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Tone Curve Adjustment

You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.122).

Select the tone curve mode and interpolation

method.
RAW | RGB | NR/Lens/ALO
|Tone CUrve assist Ol E2e ‘
Tone curve adjustment = ‘
RGE “R'_V c | B 7|
255 '
v Curve
Straight L
<control> + click inside
v RGBERGE the graph to display the
Luminance R G B menu
il
D_ 1|
o] 255
Brightness: .:.:.....|.\.’-|:.:...... 0 1
Contrast PSR TR of:
Hue: T A e 2 o i
Saturation: .D\” E 100 3
Sharpness: !‘\:/'l"—' B 0 :

Make adjustments.

Batch adjusts RGB
Adjusts each channel

——+— RAW | ROB | NR/Lens/ALO

|Tone Curve assist S e |
Tone curve adjustment -y |
R[] r [ c | s J [ #]
2552
_D-___ e |
0 255
Brightness: '\/' 0 _
Contrast: "‘:"v' _Di
Huze: Ry e, 2 0.
Saturation: .DV Eﬁi
Sharpness: t:I"—-v 9—0:

Click to add a [[] (point)
Adjust by dragging [[]

The horizontal axis shows the input level and the vertical axis

shows the output level.
The maximum number of [[]] is 8.

To delete a [[], double-click on the [[]].

The histogram display changes according to adjustment. You can

also fix the histogram display to the display before any

adjustments (p.76).

The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.76).
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Introduction

Adjusting Dynamic Range @ The setting range of shadow points is 0 to 247 (in 1-stop —
D , idth of aradati ion) from dark points to bright increments when entering a value).
ynamic range (width of gra ation expression) from dark points to brig The setting range of highlight points is 8 to 255 (in 1-stop Contents at
points in an image can be adjusted. . ;
increments when entering a value). a Glance

The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any

Move downwards

Output highlight points adjustments (p.76). Basic
Operation
RAW | RGB | MNRy{Lens/ALO
|Tone curve assist [ [ |&|@||
Tone curve adjustment Ej-— Reverts the deantc._‘.ed
e, HENEEE E image to the peration
Output ——— 259 orlg!nal
highlight point settings Advanced
numerical Image Editing
Processing
Move to the — Move to the Large Numbers
right left of Images
Input shadow Input highlight
points points Edjtihg
J JP§IFF
_ i | es
Outputshadow |— ¢ J
pointnumerical 0 2551 Input highlight
value Erightﬂells: S — 0':| point numerical Reference
Ca S w | value
Input ShadOW— s (IR RREREN (R A RRARNRRT] Di e
point numerical | Hue: e D 0[]
value Saturation: (o) 100]) Index
Sharpness: @—””””_‘m””m“ |g UE ]
Move upwards
Output shadow points @ @
The horizontal axis shows the input level and the vertical axis shows @
the output level. Q
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Reducing Noise

You can reduce noise that arises in JPEG and TIFF images that have
been shot at night or with a high ISO speed.

Select the [NR/Lens/ALO] tab sheet from the tool
palette in the edit window or edit image window.

Click the [NR Preview] button.
|Maise reduction

RAW ﬁ NR Preview... |

The [NR Preview] window appears.

Adjust an image.

ann NR Preview

Navigator
window

— Enlargement

display
TIFF/JPEG pOSitiOﬂ
Luminance noise reducy
2 S = Drag the
B = 20 sliders

- Cancel ) ( Apply )

|
NR check window

You can set a noise reduction level from within a range of 0 to 20.
The larger the setting, the larger the noise reduction effect.

The noise reduction effect can be checked when an image is
displayed at 100% in the NR check window.

You can change the display position of the NR check window by
dragging the enlargement display position in the navigator
window.

Click the [Apply] button.
Noise reduction is applied to the image and the image is
redisplayed.

Ny

== To set the same noise reduction level for several images

After selecting multiple images in the main window, you can set the
same noise reduction level for the images without displaying the [NR
Preview] window, by adjusting the noise reduction level in the [NR/Lens/
ALQ] tool palette (p.112) using the [Luminance noise reduction] and
[Chrominance noise reduction] sliders, and then clicking the [Apply]
button.

@ If [Luminance noise] has been set, resolution may be reduced
along with reduction of noise.
If [Chrominance noise] has been set, color bleeding may occur
along with reduction of noise.
You can set the batch processing settings for noise reduction
beforehand, using [Default noise reduction settings] in the [Tool
palette] tab sheet in the [Preferences] (p.76). This is particularly
useful for applying noise reduction to all the images in a folder at
once, such as batch noise reduction for images with high ISO
speeds. However, where images have a recipe attached, the
noise level recorded in the recipe is applied.
For a list of [NR Preview] window functions, refer to p.113.
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Trimming and Adjusting the Angle of an Image

You can trim only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical. You can also adjust the angle of an image before trimming.
When aspect ratio information is attached to an image shot with EOS-
1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark Ill or EOS 7D, the
trimming range based on the aspect ratio information is displayed.

Select the image to be trimmed.

Open the trimming/angle adjustment window.

Select the [Tools] menu » [Start Trimming/Angle Adjustment tool].

The trimming/angle adjustment window appears.
Editing can be done once the trimming/angle adjustment window
has reached a clear display.

Adjust the angle of the image as needed.
Trimming/angle adjustment window

[¥ 1/1 IMG_0001JPG [3456 x 2304] ]

Largest
possible
trimming
range

=) — Click(rotate
image left
or right in
90-degree
increments)

|
Drag*® (0.01-degree increments;
adjustment range: -45 to +45 degrees)

Use the mouse (click A/V) to adjust the angle or
directly enter the adjustment angle* (0.01-degree
increments; adjustable range: -45 to +45 degrees)

* You cannot adjust the angle of images that exceed 6666 x 4444
pixels in size.

If you click [Center on Screen], you can display the trimming
range in the center of the window.

If you click the [OK] button after adjusting only the angle of the
image, the image will be trimmed at the largest possible trimming
range.
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Select a ratio and drag the trimming range.

806 [¥ 1/1 IMG_0001.JPG [3456 x 2304]

trimming
ratio

Drag the
trimming
range

( copy J{ Paste

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.

List of aspect ratios (width : height)

v Free
1:1
3:2
2:3
4:3
3:4
5:4
4:5
A Size Landscape
A Size Portrait
Letter Landscape
Letter Portrait
Custom

[Free]: You can trim an image to any size, regardless of the
selectable ratio.
[Custom]: You can trim an image at the specified ratio.

Click the [OK] button to return to the main window.
The trimming range frame is displayed in the trimmed image
(p.109).

When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its trimmed form.
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? About trimmed images

The trimmed range can be reverted to its original condition at

any time

A trimmed image is displayed or printed as a trimmed image.

However, since the image is not actually trimmed, you can always

revert to the original image by clicking the [Reset] button in the

trimming/angle adjustment window or performing the “Re-Editing an

Image” procedure (p.103).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.109).

 Edit window:

+ Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image

You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when saved as a separate

image

The trimmed JPEG or TIFF image actually becomes a trimmed image

when saved as a separate image (p.103).

Images that have aspect ratio set will be displayed as trimmed

images

When aspect ratio information is attached to an image shot with EOS-

1D Mark 1V, EOS-1Ds Mark 1ll, EOS-1D Mark Il or EOS 7D, the set
trimming range based on the aspect ratio information is displayed.
However, since the image is not actually trimmed, you can change the
trimming range or revert to the condition before trimming.

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.117).

The image is displayed in its trimmed condition.

A/

-@Q)> Convenient functions of the trimming/angle adjustment
window

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming/angle
adjustment window. With the trimmed image displayed, click the
[Copy] button and then click the [Apply All] button. This will apply the
trimming range to all the images selected when the trimming/angle
adjustment window is displayed.

® For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view image details in the trimming/
angle adjustment window, so using this function is not
recommended.

@ For a list of the trimming/angle adjustment window functions, refer
to p.117.
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Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images shot with the camera
that can attach this data, can be used to automatically erase dust spots.

Compatible Cameras

EOS-1D Mark IV EOS-1Ds Mark 11l EOS-1D Mark Il
EOS 5D Mark Il EOS 7D EOS 50D

EOS 40D EOS 550D EOS 500D

EOS 450D EOS 400D DIGITAL EOS 1000D

In the main window, select an image appended with
Dust Delete Data.

Select the [Tools] menu » [Start Stamp tool].
The copy stamp window appears.

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

806 ¥ 1/2 IMG_0050.JPG [3456 x 2304]

6116 100% View to perform stamp eperation. %/

Dust spots are erased in a single operation.

Click the [OK] button to return to the main window.
The [@,] mark (p.109) is displayed on an image from which dust
spots have been erased.
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? Additional Information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.103).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.100) or the copy stamp function (p.102).

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.103).

A/

~
-

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

@ For a list of the copy stamp window functions, refer to p.119.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].

Dust spots in all the selected images are erased in a single
operation.
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the dust spot is light in color, click the [ »( ) |] button.
When you move the cursor over the image, the dust erasure
range appears as [O].

Manually Erasing Dust (Repair Function) .
Introduction
You can erase dust spots in an image by selecting them one by one. Place the dust spot to be erased within the [O] and
click.
In the main window, select the image you want to c
ontents at
erase dust spots. a Glance
Select the [Tools] menu » [Start Stamp tool].
The copy stamp window appears. Basic
. . . Q Click Operation
When the image has redrawn itself, double-click the
point from where dust is to be erased.
Advanced
Operation
' Advanced
Image Editing
e : and Printing
Double- - .
click The dust spot within the [O] is erased. Processing
Click on another part of the image to continue erasing dust spots Large Numbers
. . of Images
in the image.
To erase dust in another part of the image, click the button
clicked in step 4 again to cancel dust erasure processing and JFI,E |§|’=F
perform the operation again from step 3. | es
When the dust spot cannot be erased, [()] is displayed.
The display changes to 100% view. Click the [OK] button to return to the main window. Reference
The display position can be changed by dragging. The [&] mark (p.109) is displayed on an image from which dust
. spots have been erased.
Click the button that matches the dust spots to be P
erased. Index
If the dust spot is dark in color, click the [ @ ) [] button, and if

00
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.102).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.103).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.103).

Ny

~
-

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 5, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 5, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

To apply dust erasure to the same place in several other images, you
can efficiently erase dust spots by clicking the images while holding
down the <38> key in the main window, or, by selecting multiple
images by clicking the first image and then clicking the last image
while holding down the <shift> key, and then displaying the copy
stamp window.

@ For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.

@ For a list of the copy stamp window functions, refer to p.119.
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Saving Editing Results .
Introduction
Erasing Unwanted Parts of an Image (Copy Stamp Function) Saving Editing Content to an Image
You can correct an image by pasting a section copied from another part All the contents (reci : ;
. . pe) adjusted with the tool palette (p.87 to p.94) as Contents at
of the image to an unwanted part of the image. well as the trimmed range (p.95) and dust-erasure (p.98 to p.102) a Glance
. . . information can be saved to a JPEG or TIFF image, or to a separate
Follow steps 1 to 3 in “Manually Erasing Dust (Repair JPEG or TIFF image.
Function)” (p.100). Basic
. . . Select the [File] menu » desired item. Cperaties
Specify the section to be copied.
Click on the section that is to be the copy source while holding
down the <option> key Open in Edit window #0 Advanced
Rt ) Open in Edit window (enlarged) Operation
To change the section that is to be the copy source, perform the Clase all
operation above again. Open window N
To fix the position of the copy source, checkmark [Fix Copy Gz window el : Advaélg_eipl
Source position]. [ save %S mage Editing
P ] SHtA A %S and Printing
Correct the image. Add thumbnail to image and save {+3T
Click or drag on the section you want to correct on the image. [+] E;';‘:;‘r;:g;m"' :BD LPrOCrﬁSSigg
in the window indicates the copy source and [Q] indicates the ag%elm:gmesers
copy destination. Create new folder... {r 38N
The copied image is pasted in the position to which it was Page setup... 1+ 36P E
dragged Print... 3P JPEMILE
’ ) Print with detailed setting... 43D I es
For [Pen type], you can select from [Brush] (the pasted image’s Contact Sheet Prints... ~3gp
borders simulate a brush) and [Pencil] (the pasted image’s Plug-in printing 3
borders are sharp). Add to collection #GC Reference
. . . R f llecti 3G
Click the [OK] button to return to the main window. o Lo
The [@,] mark (p.109) is displayed on a corrected image. Delia e
Info... £ Index
Your adjustments are saved to the image.
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Saving as a Separate Image

If a JPEG or TIFF image is adjusted with the tool palette (p.87 to p.94)
and then saved in the same way as a RAW image as described below,
the image can be saved as a separate image with the adjustments
(recipe) applied to it.
Furthermore, if a trimmed image (p.95) or dust-erased image (p.98 to
p.102) is also saved in the same way, it actually becomes a trimmed or
dust-erased image.

Saving as a JPEG or TIFF Image (p.39)

Batch save as JPEG or TIFF images (batch processing) (p.83)
By saving as a separate JPEG or TIFF image as explained above, the
adjustments made with the tool palette are applied, and some image
deterioration that accompanies editing/saving occurs as when editing
with ordinary image editing software.

Applying Editing Contents to Another Image

You can copy the adjustment contents (recipe) of JPEG and TIFF
images that have been adjusted with the tool palette and apply them to
another image with the procedures below, in the same way as with RAW
images.

Applying adjustment contents to another image (p.38)

Utilizing adjustment contents (recipe) (p.80)

Printing
Edited JPEG and TIFF images can be printed with the procedures
below as with RAW images.

Printing (p.40)

Printing with shooting information (p.69)

Printing a thumbnail list (contact sheet printing) (p.70)

Printing RAW images on a high-end Canon printer (p.71)

Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.87 to p.94), so the “original image data itself”
remains unaffected. Also, the trimming range or dust-erasure
information of a trimmed image (p.95) or dust-erased image (p.98 to
p.102) is simply saved to the image.

For this reason, you can undo any adjustments saved (p.102) to the
image, trimming range and dust-erasure information, and revert to the
condition when last saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu » desired item.

Rotate Left L
Rotate Right R
Add check markl FBF1
Add check mark2 HF2
Add check mark3 #F3
Clear check mark FHF4
Work color space >
Tone curve assist - Standard

Tone curve assist - High

Revert to last saved settings “C3Z
Revert to shot settings ~¥HZ

The image reverts to the conditions of the selected item.

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

E g
JP IFF
| es

Reference

Index

00
©

103



Reference

This reference section has been provided to enhance your experience
using DPP.

It contains various troubleshooting solutions, how to delete DPP from
your computer, explanations of the various windows and a glossary.
An Index is provided at the end of the chapter for you to easily find
information you are looking for.

Troubleshooting...........coiiiiiiiiiii 105
Deleting the Software (Uninstalling) ...................... 106
List of Main Window (Folder Window) Functions .. 107
List of Main Window (Collection Window) Functions... 108
Image Frame Information in the Main Window and Edit

Image WindoW ... 109
List of Edit Window Functions .............ccccceeevnnnnnee. 110
List of Tool Palette Functions ............cccoveeveiennnnn... 111
List of NR Preview Window Functions................... 113
List of Quick Check Window Functions.................. 114
List of Edit Image Window Functions .................... 115

List of Convert/Save One Image Window Functions 116
List of Trimming/Angle Adjustment Window Functions 117
List of Lens Aberration Correction Window Functions 118

List of Copy Stamp Window Functions.................. 119
List of Convert/Save Multiple Images Window (Batch
Processing) Functions...............cccccceeiiiiviiiiiie e, 120
List of Rename Window Functions........................ 121
GlOSSAIY ..o 122
INAEX .. 124
About This Instruction Manual.............................. 128
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Troubleshooting

If DPP is not operating correctly, refer to the items below.

Introduction

Installation could not be completed correctly

You cannot install software unless you are logged into an account with
Administrator privileges. Log in again into an account with
Administrator privileges. For how to log in and how to specify
Administrator settings, refer to the User’s Manual for the Macintosh
computer you are using or for OS.

DPP does not work

DPP does not operate correctly on a computer if its system
requirements are not met. Use DPP on a computer with compatible
system requirements (p.3).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.3), if other applications are running at the
same time as DPP, you may not have sufficient RAM (memory). Quit
any applications other than DPP.

The card reader does not detect the SD card.

Depending on the card reader and computer OS used, SDXC cards
might not be correctly detected. In such a case, connect your camera
and computer with the provided interface cable, and transfer the
images to your computer using EOS Utility (provided software).

Images do not display properly

Images that are not supported by DPP do not display. There are
various types of JPEG and TIFF images, so JPEG images other than
Exif 2.2 and 2.21 compatible images and TIFF images other than Exif
compatible images may not display properly (p.3).

When a dust-erased image (p.64 to p.68, p.98 to p.102) is displayed
in a window other than the copy stamp window, it is displayed as it
was before dust erasure was performed. Check dust-erased images
in the copy stamp window.

An image could not be adjusted

The JPEG and TIFF images cannot be adjusted using the image
adjustment function of the [RAW] tool palette. Adjust these images
with the [RGB] tool palette (p.111).

A recipe could not be pasted (applied) to another image

You cannot paste (apply) rotation (p.10, p.23, p.107, p.114, p.115),
trimming (p.35, p.95), dust erasure (copy stamp) (p.64 to p.68, p.98 to
p.102) of an image to another image as a recipe. Trim the image or
erase dust of the image using the copy/paste function in each window
and rotate each image individually.

The adjustment contents (recipe) of RAW images that has been
adjusted with the [RAW] tool palette cannot be applied to JPEG or
TIFF images (p.111).

The Auto Lighting Optimizer (p.58) is a function that is only available
for RAW images shot with EOS-1D Mark IV, EOS 5D Mark Il, EOS
7D, EOS 50D, EOS 550D and EOS 500D. You cannot apply the Auto
Lighting Optimizer’s adjustment contents to RAW images shot with
other cameras.

Color appears weak in the image when viewed with
other software

A RAW image which has a color space other than sRGB set (p.68,
p.77) and is then converted and saved as a JPEG or TIFF image will
appear weak in color when viewed in software that is only compatible
with sRGB color space. In this case, set the RAW image color space
to sRGB, convert again to a JPEG or TIFF image and save, and then
view this image.
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The colors of the image displayed on screen and
the colors of the printed image do not match

If the color of the monitor that displays an image is not adjusted
correctly, or if a profile for a printer that is to print images, has not
been set up, the color of the image displayed on screen and the color
of the printed photograph may differ greatly. If the color of the monitor
that displays images is corrected (p.77) and a profile for a printer is
set up correctly (p.77), the color of a printed photograph and the color
of an image on screen can be more closely matched. Using a Canon
printer (p.40, p.43) or linked printing (p.71, p.72) automatically sets up
printer profiles, so you only need to set the color of the monitor to
bring the colors closer together.

When printing using Easy-PhotoPrint and the Easy-PhotoPrint
automatic compensation function and the various types of image
adjustment functions are operating, colors are not printed correctly.
Cancel all Easy-PhotoPrint image adjustment functions (p.44).

Even if you set a printer profile, if you use the color adjustment
function of the printer driver, the image may print in colors different
from those displayed on screen. Do not use the color adjustment
function of the printer driver.

Printing a large number of images in batches cannot be performed

If a large number of images are printed in batches, printing may stop
in the middle or the images may not be printed. Reduce the number of
images to print or increase the memory on your computer.

A file remains in the folder after images are deleted

Delete [CRW_YYYY.THM] (camera index display image) if it remains
in the folder from which images have been deleted (p.46).
* Numbers are entered for [YYYY] in the file name.

The image information does not display

A JPEG image set to Adobe RGB and shot with EOS 10D and EOS
DIGITAL 300D DIGITAL may not display image information (p.10,

p.21).

Deleting the Software (Uninstalling)

Quit any applications before uninstalling the software.

Log into the account used when installation was performed.

When you have moved the folders and the software to be deleted to
the Trash, select the [Finder] menu » [Empty Trash] and empty the
Trash. You cannot reinstall the software until you have emptied the
Trash.

Display the folder in which the software is saved.
Open the [Canon Utilities] folder.

600 + Applications =
sn =
[« »J{28= mj{ -] a
[ - g =
= Sa 9 ¥
vl Lo | 6id
id MacOS_10.4 > =
] Mail OmniGraffle OmniQutliner
i} Dara 01
o - &
4 .
G oeskoos &% Q &
Ags caran Preview QuickTime Player Saf:
=g Applications @
|5 Documents N : - I
o Sherlock Stickies System Preferences
'7% Movies
é Music 4
= i’
| Pictures E: s
= TextEdit Utilities Canon Utilities
> — 37 items, 217.24 GB available =

Drag the folder for the software to be uninstalled to
the Trash.

Select [Finder] menu on the desktop » [Empty Trash].

The software is deleted.
When uninstallation ends, restart your computer.

@ You cannot retrieve data that you have emptied into the Trash and
deleted, so be particularly careful when deleting data.
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List of Main Window (Folder Window) Functions .10

Shows/hides the tool palette (p.111) Check marks (p.18)
Shows/hides the folder area Selects all images Removes check marks (p.18)
Switches to the edit image Cancels selection of all images Folder path ‘ Image rotation (90 degree units)

Introduction

—_—

Contents at

window (p.115) ‘| a Glance
@ Digital Photo Prpfessiongl File [dit View Bookmark Adjustment Tools Window Help E 4
Digital Photo Professional - [ MacOSX/Users/canon/Pictures/Photo/xxxx_xx_xx ]
Toolbar*" :
, Batch conversion/ Basi
[Collection] tab sheet*® i

saving Operation

*5
[Folder] tab sheet ——ta (p.83, p.84, p.120)
B | & Applications
[ Temporary Items
oo <t Advanced
¥ B Desktop Operation
[ Travel
# |7 Documents
> B Library
# Movies ~ MG_O0DL.CRZ '7|i‘rj_-jE-dé'ti’z'7' 7&.‘5’_0’:@4 2 |am
& Music - - - - ~ - Advanced
/BB matices Image Editing
< — and Printing
B [& Public
P [ Sites
» [ shared =
Processing
& @ @ - - Large Numbers
Folder area*2 _ D e o P L S INGOOBS CRein 0l ca R ROS Ca e MG RO G of Images
Editing
JPEGITIFF
Images
~— ——
i_l’i"c;-f-'c-i'z'ch'z' - " IMCODI3.CRZ _"ie.i'il-jb'i'-i w2 _"'\i.'tj'c-i's.fiiz'_r
Reference
J
| Adobe RGE / Adobe RGE High quality Recipe data Yes Number of images: 15 Number of selected images: 1 oMR—————2— CMYK simulation

display (p.77)

| |
Display mode** Number of selected images

Image color space and work

*3
color space™ (p.68, p.77) Recipe attachment status (p.80) Number of displayed images

*1 To switch between show/hide, select the [View] menu » [Toolbar]. *4 The item selected in [Viewing and saving RAW images] (p.73) of the @
*2 The images inside the folders selected here are displayed in a [Preferences] window is displayed. _—
thumbnail list on the right. *5 You can switch between the [Folder] and [Collection] windows.

*3 Displays the coordinates of the cursor position and the RGB values (8-bit
conversion) when click white balance was performed with the tool palette. 107



List of Main Window (Collection Window) Functions 33 o
Shows/hides the tool palette Check marks
Selects all images Removes check marks
Switches to the edit image Cancels selection of all images ‘ Image rotation (90 degree units) Contents at
window .| a Glance
@ Digital Photo Prpfessiongl File [dit View Bookmark Adjustment Tools Window Help E 4 |Wed3:13PM Q
ena Digital Photo Professional - [ Collection]
Toolbar :
Collection] tab sheet*” Batch conversion/ Basic
[Collection] tab shee saving Operation
[Folder] tab sheet
. Advanced
Operation
o IMC_0001.CR2 & " IMCo002CRZ @ & ~ MG_00D4CRZ @ & "~ IMC_0006.CRZ ~ IMG_ODO7.CR2
o - i GE @ MG000 BE @y M0 =) C e M BN AR - Advanced
Image Editing
and Printing
Processing
Large Numbers
of Images
Editing
JPEG/TIFF
Images
Reference
| Adobe RGE / Adobe RGE High quality Recipe data: Yes Number of images: 7 Number of selected images: 1 oMR—————2— CMYK simulation
. | ! _ display
Image color gpace and work Display mode Number of selected images
color space™ (p.68, p.77) Recipe attachment status Number of displayed images @ @
*1 The total number of images added to the [Collection] window is *2 Displays the coordinates of the cursor position and the RGB values (8- @
displayed in the () in the [Collection] tab sheet. Accordingly, when an bit conversion) when click white balance was performed with the tool =
image is added that is displayed as a single image (p.20), twice the palette.

total number of displayed images is displayed.
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Image Frame Information in the Main Window and Edit Image Window .10, p.31)

Information displayed when [Large thumbnail] (p.10) is selected

Digital Photo Professional - [ MacOSX /Users /canon

Folder
Check mark v 2 MacOsX
. At Copy stamp mark
(p.17, p.18) o 1 Applications gzt 6% o8
|~ Temporary ltems (p. 0 p.bg, p. (6]
¥ [& Users p.102)
v & canon Lens aberration
> [ Deskiop correction mark (p.62)
| = Travel
b | Documents _ _ .
> @ Library Trimming range*®
= Movies (p.35, p.95)
Brightness adjustment & Musie
value*' (p.24) v | Pictures X
v [ Photo Aperture*3
> Puit-}-l-i'c*m—“—“ @ '|':T_db’i:i.é'r{z' : ;a;ﬁﬂ ' MC_0002.CRZ

RAW adjustment mark*! *4
RGB adjustment mark*"! *>

Unsaved editing content mark

White balance icon*! (p.25) File name

Image type*2
Shutter speed*3

*4 Displays in an image edited with the [RAW] tool palette in the edit
window and the edit image window.

*5 Displays in an image edited with the [RGB] tool palette in the edit
window and the edit image window.

*6 When aspect ratio information is attached to an image shot with EOS-
1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark Il or EOS 7D, the image
is displayed as a trimmed image.

*1 Does not display with [Small thumbnail].

*2 Displays in RAW+JPEG images displayed as a single image (p.20).
[RAW] is displayed in RAW images.
(In [Small thumbnail] (p.10), [R] is displayed.)

*3 Does not display with [Medium thumbnail] or [Small thumbnail].
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List of Edit Window Functions .11, p.23)

Path and file name of image

Tool palette*! (p.111, p.112)

6 (81&) E Digital Photo Professional - [ MacOSX/Users/canon/Pictures /Phaoto/xocxo_xx_xx IMG_0001.CR2 ]

(1576, 1021 ) : 157, 165, 189

Higlh quality RAW Adobe RGE CMITK'///j

@00 # IMG_0001.CR2

—{--m | RCE NR/Lens fALO

|!righmes; adjustment

B

0.00

|White balance adjustment

71

| Shot settings

|Pim|le Style

" Standard

100 5.0 -6.0 -40 -2

Contrast: '_e_‘
(0 o

Color tone: —
o Voo ! i

Calor

(0) C

o TSR

Information display*? Display mode*4

Image color space*3 and work color space (p.68, p.77)

*1 To switch between show/hide, select the [View] menu » [Tool palette].
*2 Displays the coordinates of the cursor position and the RGB values (8-
bit conversion).

*3 RAW images are displayed with [RAW].
*4 The item selected in [Viewing and saving RAW images] (p.73) of the
[Preferences] window is displayed.

CMYK simulation display (p.77)

}
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List of Tool Palette Functions

RAW Tool Palette (p.23)

|nn ¥ IMG_0001.CR2

{ RAW | RGB  NR/Lens/ALO —

-
| Erightness adjustmant

7] NEE

_' Shot settings s ] [ Tune..

|

-
Picture Style

Standard

\
) Browse... )
/

hYd

'-10_0 -8.0 -60 -40 -20 O 2.0

)

\ 4.0 y

Contrast: L=
(0) R

)
Highlight: r
(0} N [T
Shadow: L=
0) Y
! Linear

)
Color tone: =r
i0) T
Color saturation:

T Uy

o )
Sharpness: b ———]

1 1Y

* If an image is displayed enlarged, the enlargement display position can be

——— Brightness adjustment (p.24)

—— White balance adjustment

(p.25, p.26, p.53)

——— Picture Style settings (p.24, p.56)

L Dynamic range adjustment (p.54)

Contrast adjustment (p.27)

Shadow/highlight adjustment
(p.54)
Linear setting (p.27)

Color tone and color saturation
adjustment (p.27)

Sharpness adjustment (p.29)

Enlargement display position*

moved by dragging. The enlargement display position appears when

[Docking display] (p.76) has been set and the edit image window (p.115)

has been enlarged.

RGB Tool Palette (p.57)

00 ¥ IMG_0001.CRZ
L~ Automatic adjustment
e B (tone curve assist) (p.30, p.88)
Tone curve adjustment 3
RGs | r|c|s| o~ Click white balance (p.90)
255
- Tone curve adjustment
(p.55, p.92)
- Dynamic range adjustment (p.93)
0 .
u] 255
i = = Brightness and contrast
rightness: i Ew v A
Contrast: o e ) ) 1] ':' adJUStment (p89)
(g -
. = b = . .
ol J i L A Hue and Saturation adjustment
Saturation: ”@” N 2 100 5 ( 91)
Sharpness: ——— 3= 0 _ p.

Sharpness adjustment (p.91)

Enlargement display position*
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Introduction
NR/Lens/ALO Tool Palette NR/Lens/ALO Tool Palette
(When a RAW image is selected) (When a JPEG or TIFF image is selected)
000 I¥) IMG_1001.CR2 aTals ¥ IMG_1001JPG Contents at
[ RAW  RGE | NRfLens/ALO | ——— RAW  RCB | NR/LensfAlO }—— a Glance
IAntn Lighting Optimizer I |Autn Lighting Optimizer |
s @ T . Auto Lighting Optimizer (p.58) v Basic
\l Low  Standard  Streng ) Low  Standard  Strong Operation
|Noise reduction l—ﬂplﬂm— Apply noise reduction button (p.59) |Noise reduction L—MNV_TI— Apply noise reduction button (p.94)
R ~__nreeview. 71— Displays the [NR Preview] window R __weeiew. -+ Displays the [NR Preview] window
: minance noise reduction (p94’ p1 13) . minance noise reduction 947 113
( = o —— Luminance noise reduction for s i Sor (p-94, p-113) gg‘é?:ggg
RAW |mageS (p59) Chrominance noise reﬂu::t_il?.r? ;
3 - Chrominance noise reduction for 2 - G
TIFF/JPEG RAW images (p.59) TIFE/JPEG Advanced
Luminance noise I‘!dutl.i(ff_i. ( Luminance noise reduction J— Luminance noise reduction for Image Edltlng
g]lmrfinance noise I'fﬂul‘.‘[iﬂn ° gmmname noise :duamn - = JPEG and TIFF images (p94) and Prlntlng
© 0 © = o o = % L Chrominance noise reduction for = ;
Lens aberration correction Tune... j—l— LenS aberration Correction tuning |Lens. aberration correction | JPEG and TIFF imageS (p94) Larrgoecﬁls]z]lgegrs
button (p.62) of Images
Peripheral llumination 63 P
Distortion OFF . . Distorti P
; : —— Lens aberration correction (p.62) e Editing
Chromatic aberration OFF Chromatic atior JPEG/T'FF
L Color blur OFF J Color biur Images
Reference
——— Enlargement display position* ——— Enlargement display position*

* If an image is displayed enlarged, the enlargement display position can @
be moved by dragging. The enlargement display position appears
when [Docking display] (p.76) has been set and the editimage window
(p.115) has been enlarged. 112



List of NR Preview Window Functions .59, p.94) .
Introduction
Contents at
{B N MR Preview 7 a Glance
Basic
Operation
Enlargement displa
positign i Advanced
Operation
Navigator window
Advanced
Image Editing
(RAW) Image type* and Printing
Luminance noise reduction ) . .
[{m 0 O 5 Lummgnce noise Processing
?IIIIIIIIIIIIIIIIIII - reduCtlon LargeNumbers
Chrominance noise reduction ) . . of Images
(0) o - 20 Chrominance noise
( ) ( = Zadulctlon. ducti Editing
Cancel r Apply )—'— pply noise reauction JPEG/TIFF
button Images
h, -«
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NR check window

* When you select a JPEG or TIFF image and display the [NR Preview]
window, [TIFF/JPEG] appears and you can reduce luminance noise
and chrominance noise for the JPEG and TIFF images.



List of Quick Check Window Functions .15 p.17)

50% view/100% view (moiré reduction off)/full view*'

File name of image

@ 2/15 Ih:"IG_OOGZ.CRZ [3456 x 2304]

| . )
[ Full screen ']_
Check mark [m_
Nl

( Pre\:iaus ) ( Nelxt )

Check mark display

[ S50%  view J

'_1_,_' AF Point
Info... -

( Rotate left ) ( Rotate right )

S

*1 You can select 50% view/100% view (moiré reduction off) by selecting
[Preferences] in the [Digital Photo Professional] menu and using
[Quick check tool display] in the [View settings] tab sheet. You can
also move the display position in the enlarged display by dragging the
image.

*2 To return to the normal screen, press the <esc> key.

‘ Check marks (p.17)

Displays theimage
in full screen*?
Removes check
marks (p.17)

Switches between
displayed images
Displays the AF
points (p.16)
Displays the image
information window
(p.22)

Image rotation
(90 degree units)

J
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List of Edit Image Window Functions (.31, p.33 .
Introduction
Shows/hides tool palette ~ Shows/hides grid*4 Image path and file name
Shows/hides thumbnail display area Enlargement ratio of displayed image Image rotation (90 degree units)
Switches to main window Switches between displayed images Batch conversion/saving COI‘(I;tfntS at
a Glance
(p107) @ Digital Photo Prif File Edit View Afljustment Tools Windcw| Help EE ) Wed 3:18PM | (p83’ p84, p120) - )
|#| Digital Photo Professional - [ MacOSX/Jiers/canon/Pictures/Photo/xxxx_xx_xx/IMG_0003.CR2 |
i Basic
Toolbar Operation
‘ Brightness adjustment
‘Whi(e balance adjustment = =) || Advanc.ed
= Operation
Shot settings 1#)( Tune... ! —_
‘Picluru Style [=] Advanced
Standard 1) ( Browse... ) Image Editing
and Printing
D ——————————
+— Tool palette
(p.111) Processing
@ i 100 -80 -60 40 -20 0 2.0 40 Large Numbers
Thumbnail display area*3 — =& __——— i B e e of Images
[rg]gnlight: T@ﬁ
f.,; —————— Editing
ortne: JPEG/TIFF
Color saturation: ——@— Images
0 G T “-—
g Lo
Reference
— CMYK
simulation
display
Information display*?2 Laass, 119y 136, 145,178 i s waw adohercs o | (D.77)

Display mode*>

Image color space*! and work
color space (p.68, p.77)

*1 RAW images are displayed with [RAW].

*2 Displays the coordinates of the cursor position and the RGB values
(8-bit conversion).

*3 Displays images selected in the main window. The image selected
here is enlarged and displayed on the right.

*4 You can set the grid spacing with [Grid pitch] in the [Preferences] (p.75).
*5 The item selected in [Viewing and saving RAW images] (p.73) of the
[Preferences] window is displayed.
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List of Convert/Save One Image Window Functions

Types of image

(p-39)

Convert and save

File name

Save As: DPP_001

| &l

Type of image Extension
Exif-JPEG JPG
Exif-TIFF 8bit TIF
TIFF 16bit TIF

Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG

TIFF 16bit+Exif-JPEG | .TIF/.JPG

Save destination

Where: [ Photo 44
File format
Kind of file Exif-JPEG Hd
Image quality : e @ 10

Output setting

JPEG compression rate*3

Resolution*1

Size changing*4

*1 The setting range is 1 to 60,000 dpi.

*2 Color space (p.68, p.77) information that is set in an image is attached

to an ICC profile.

Even if you remove the check mark from images that have been set to

Output resolution 3|5|:| dpi ! Embed ICC profile
Resize setting )
"1 Resize

Width Height Lnit

3504 «x 2336 pixel | %
{ 3504 pixel ) {2336 pixel )
f Lock aspect ratic
J

I'; Cancel jj ( Save )7

Embeds of ICC profiles*2 (p.122)

——— Save

*3 The setting range is 1 to 10. The higher the numerical value, the higher

the image quality becomes.

*4 The larger of the two values set in [Width] and [Height] is applied to the

Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.68,
p.77), the ICC profiles are embedded automatically.

longer edge of an image and change its size.
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List of Trimming/Angle Adjustment Window Functions (.35, .95

Cancels all the trimming (aspect ratio) information

[# 1/1 IMG_0001.CR2 [3456 x 2304]

8006

[ Full

screen

J

( Clear

) ( Reset +

32

s
¥

[As pect ratio

3.00

- 2.00

)

bt

[2F 362

Height

)

704
Width
1577

3] 1051

5

[Angle

10.10

J]

et
-

( Rotate left )( Rotate right ) )

@

Coy I _Paste Y}

Ap

ply All
|

J

-
.
e
[=}
r

Full screen display/returns to normal screen

—— Reverts to the condition when the image was shot

—— Ratio of trimming range (you can also enter
numerical values if you have selected [Custom])*"

—— Upper left coordinates of trimmed range (you
can also enter numerical values)

—— Size of trimmed range (you can also enter
numerical values)

—— Angle of image adjusted

(Drag bar, use the mouse to click A/V or enter
numerical values to set angle)

—— Copies the trimmed range and applies (pastes)
it to another image*?

— Applies the copied trimming range to all other
images*2

— Switches between displayed images*?2

Level of opacity outside a trimmed range

—— Shows/hides grid lines
(Drag bar to set distance between grid lines)

Displays the trimming range in the center of the

window

..... =
__| Show Grid
[ Grid pitch ]
(S
I Center on Scréen. ; } ;
I
( Cancel ) ( 0K )

| (704,362)->(2281,1413) = (1577 x 1051) [ 1.50]

Z

Trimming range

Displays borders around a trimmed range

Image rotation (90-degree increments)

*1 If [Free] has been selected in the [Aspect ratio] list box, you can also
drag the borders of the trimmed range to change its range.

*2 Operates when you have selected multiple images and the trimming/
angle adjustment window is displayed.
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List of Lens Aberration Correction Window Functions 62 o
[ Lens aberration correction - [IMG_1001.CR2] N
: Contents at
a Glance
Basic
— Enlargement display section*" Operatlon
Advanced
Reverts to th diti hen th ok
| Reverts to the condition when the
image was shot
Shooting distance information Advanced
3 Shooting distance information =
o5 slider*2 %p 63) Image Editing
’ and Printing
sl ~ i— Peripheral illumination correction
el Processing
" Distortion ) ) ) ) Large Numbers
= i+— Distortion correction of Images
| Chromatic aberration ) i . .
= = | i— Chromatic aberration correction Editing
s ) JPEGI/TIFF
~ [ )+ Corrects blue chromatic aberration Images
3 Color blar Color blur correction
Shows/hides position of
# Navigator enlargement display section R
)" G
Enlargement display position Corrects red chromatic Grid display

(Navigator display) aberration

00

*1 The area you clicked on the image (Enlargement display position) is displayed at 200%.
*2 For RAW images shot with MP-E 65mm /2.8 1-5x Macro Photo or EF 50mm /2.5 Compact
Macro with Life Size Converter EF, the slider indicator changes to the zoom magnification.

©

118



List of Copy Stamp Window Functions (.64t pes,

p.98 to p.102)

[# 1/2 IMG_0050.CR2 [3456 x 2304]

[ 100% view ] { Full size view_}-

— Full screen display/returns to normal screen

{ Apply Dust Delete Data q—
(Light) (Dark) )

[ H

| OO @O B

{ Select Copy Source

- | Fix Copy Source position

Pen type
=) Brush _ pencil

30

Undo Redo
[ ]
(Cem e T
é (\ Previous } Next

C o

- Set to 100% View to perform stamp operation. //

— Applies Dust Delete Data (p.64, p.98)
— Types of dust to be erased (p.66, p.100)
L Specifies the copy source (p.68, p.102)
— Fixes the copy source position (p.68, p.102)
— Types of stamps (p.68, p.102)

Sets the size of the dust erasure range (p.66,
— p.100) or copy range (p.68, p.102) in a range of

5to 100 (in one pixel units) (you can also enter
a numerical value)

— Restores/redoes the image
— Copies the dust erasure range or copy range and
applies (pastes) it to another image

— Switches between displayed images*

* Operates when you have selected multiple images and the copy
stamp window is displayed.

}
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List of Convert/Save Multiple Images Window (Batch Processing) Functions (r.s3) o
Batch settings
IMG_0001.CR2 [ Shee e : = }_ Save destination Contents at
IMG_0002.CR2 MacOSX /Users fcanon/ Documents ( Browse... ) a Glance
NGO CF File format
IMG_0004.CR2
IMG_0005.CR2 Hkind of file | Exif-JPEG I D Basic
Me_0007 CRs sl i © 10 — JPEG compression rate*3 Operation
File names of images to be IMG_0008.CRZ Output setting Resolution*1
batch saved IMG_0009.CR2 e .
IMG_0010.CR2 Output resolution 350 dpi [ Embed ICC profile —— Embeds ICC pI’OflleS*2 (p122) Advanced
IMG_0011.CR2 (“Resize setting ) Operation
IMG_0012.CR2 1 Resize
IMG_0013.CR2 Width Height Unit S h . *4
IMG_0014.CR2 3456 J8 ol - 126 changing Advanced
{ 3456 pixel ) { 2304 pixel ) \'
001 3 R | & ) Image Editing
, (E 3 and Printing
Types of image Le.name
 Current file name
Type of image Extension String Processing
Exif-JPEG JPG A
Exif-TIFF 8bit TIF S File name
TIFF 16bit .TIF String Sequence number Editing
Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG ore.. 0001 s e e S
. . Eiriz DPP_00C1.JPG, DPP_00O02 PG Images
TIFF 16bit+Exif-JPEG | .TIF/.JPG { J
4 Image transfer settings )
L Fapenimage (sing seitae Batch transfer to other image Reference
L sl bt editing software (p.84)
J_ Convert RAW images only \ J Cancel \ f Execute )

Images to be converted are limited to RAW images*>

Save

*3 The setting range is 1 to 10. The higher the numerical value, the higher
the image quality becomes.

*4 The larger of the two values set in [Width] and [Height] is applied to the
longer edge of an image and change its size.

*5 Appears when you click the [Batch process] button (p.107, p.115)
without an image selected in the main window or the edit image
window. To convert RAW images only, instead of clicking the [Execute]
button, click this button.

*1 The setting range is 1 to 60,000 dpi.

*2 Color space (p.68, p.77) information that is set in an image is attached
to an ICC profile.
Even if you remove the check mark from images that have been set to
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.68,
p.77), the ICC profiles are embedded automatically.
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List of Rename Window Functions .25

MacOSX /[ Users/canon/Pictures /Photo/ xxooo_ xx_xx

.

—

(" File Name Extension b
DPP i~ Shooting Date/Time 3 Sequence number E] Do not change E]
J

Sort

Order in which images are sorted

Check mark to apply the same —
name to RAW images and JPEG
images recorded simultaneously

Check mark to copy the images

-
. File Name

|

( Basic Settings

f*) Fit to main window

 shooting Date/Time

( Formatsewings

Sequence number

Shooting Date/Time

Month Day Year

( __ Copy & Rename

) MM-DD-YY

Click the [Browse] button and set
the save destination

MacOSX/Users /canon/Desktop

E Insert underbar

N\

0001 | Save sequence number

3
3

§ J
Original File Maodified File Name
IMG_0001.CR2 DPP_09-13-06_0001.CR2
IMG_0001JPG U DPP_09-13-06_0002.JPG U
IMG_0002.CR2 DPP_09-13-06_0003.CR2
IMG_0002 JPG DPP_D9-13-06_0004.JPG
IMG_0003.CR2 DPP_09-13-06_0005.CR2
IMG_0003 JPG — DPP_D9-13-06_0006.JPG
IMG_0004.CR2 DPP_09-12-06_0007.CR2
IMG_0004 JPG DPP_09-12-06_0008JPG
IMG_0005.CR2 DPP_09-13-06_0009.CR2
IMG_0005 JPG . DPP_09-13-06_0010.JPG =
€ - = 1r € = ;) a“r

( Cancel

| Coeane )

Sets the new file name

Sets the format of information

in the file name
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Glossary
RAW image

EOS DIGITAL camera RAW images are recorded in an uncompressed
14bit or 12bit format.

Because RAW images are special images in an undeveloped status,
you need software with development processing functions such as DPP
in order to view them. The advantage of the undeveloped RAW images
is that you can make a variety of adjustments to RAW images with
almost no deterioration of the image.

* “RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image

The most ordinary image in non-reversible compressed 8bit format.
The advantage of this is that by saving at a high compression rate, the
file size can be small, even for image data that has a high pixel count.
Because during saving and compression part of the data is thinned out
to make the file size small, every time you edit or save, the image
deteriorates.

With DPP, even if you repeat editing/saving, only the recipe data is
modified, and no overwriting or compression occurs so the original
image data does not deteriorate.

* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image

Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for
saving an image while maintaining the original high image quality.

* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe

The “Image processing conditions information” for RAW images that can
be edited in DPP is called a “recipe”.

Further, in DPP, you can perform image editing on JPEG and TIFF
images that use “recipes” as with RAW images.

bit number

Binary unit of information volume in the color of an image. The number
shows the number of bits per pixel.

The larger the number of bits, the more the color numbers and the
gradation becomes smoother. A one-bit image is a black-and-white
image.

Color Management System (Color Matching)

Digital cameras that shoot images, monitors that display images, and
printers that print images each have a different way of creating color. For
this reason, there may be a difference between the color of an image
when viewed on a monitor and when printed.

A color management system is a system for managing color in order to
bring these colors closer together. With DPP, you can more closely
match color between different devices using ICC profiles between
different devices.

ICC profiles

ICC profiles are files containing color information such as color
characteristics and color space for various devices, set by the ICC
(International Color Consortium). Most devices such as the monitor we
use to view images or the printer we use to print images can be
managed (color management) using these ICC profiles and the color
between different devices can be more closely matched.

DPP has color management that uses these ICC profiles.

Tone Curve

A tone curve shows values before adjustment (input) as the horizontal
axis on a graph, and the values after adjustment (output) as the vertical
axis. Since the values of before adjustment and after adjustment are the
same before any adjustment is made, the tone curve displays as a
straight line from bottom left to top right, and by changing this tone
curve, you can adjust in detail the image’s brightness, contrast and
color. The more you go right on the horizontal axis, the more the plus
value it becomes, and the higher you go on the vertical axis, the more
the plus value it becomes.
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Introduction
Color space CMYK simulation profiles
A color space is the reproducible color range (color gamut A profile that simulates colors when printing in a CMYK environment
characteristics). DPP supports the following five kinds of color space. (printing machine, etc.). With DPP, you can simulate color with four Contents at
sRGB : Standard color space for Windows. Widely used for types of profile. a Glance
the standard color space of monitors, digital Euro Standard : Profile normally used for book printing in
cameras, and scanners. Europe, suitable for simulation of standard
Adobe RGB : A wider color space than sRGB. Mainly used for European printing. Basic
printing for business purposes. JMPA . Profile normally used for book printing, etc. in RpSratos
Apple RGB : Standard color space for Macintosh. A slightly Japan, suitable for simulation of magazine
wider color space than sRGB. advertising standard color printing. Advanced
ColorMatch RGB : A slightly wider color space than sRGB. Mainly U.S.Web Coated : Profile normally used for book printing in Operation
used for printing for business purposes. North America, suitable for simulation of
Wide Gamut RGB : A wider color space than Adobe RGB. North American standard printing.
Refer to the color chart below for the color area of each color space. JapanColor2001 type3 : Profile becoming a standard in the Japanese Advanced
Fatio ; ; ; Image Editing
printing industry, swtablg f_or simulation of and Printing
Color chart of color spaces compatible with DPP JapanColor standard printing.
LProcrﬁssigg
y . .
" Rendering intent T images
E— Adobe RGB Rendering intents are color conversion methods when printing an image.
p— %E’f’iﬁ{fgs The conversion method of each rendering intent is shown below. Editing
06 Perceptual : Before and after conversion, all colors are JPEG/TIFF
Color range that can be converted to maintain the relationship between LEED
seen by the human eye colors. Even where colors slightly change, you
04 can print a natural-looking image which has
maintained color harmony. However, Reference
depending on the image, the saturation may
02 change overall.
Relative Colorimetric : There will not be much conversion to colors
which are similar before and after conversion,
0 02 04 08 08 X but colors which are not similar are converted
appropriately. Because there are little changes
Gamma White point to similar colors which comprise most of an @ @
value (color temp.) image, you can print a natural-looking image in
— | sRGB 2.2 6500K(D65) which the saturation has not changed greatly.
R Adobe RGB 2.2 6500K(D65) However, depending on the image, there are
............ Apple RGB 1.8 6500K(D65) cases where the overall tone of an image
———- ColorMatch RGB 18 5000K(D50) qha_nges somewhat as colors which are not
______ Wide Gamut RGB 292 5000K(D50) similar and highlights change. 123




Index

A

AdJUSt JPEG IMAQgES....ccoiiiiiiiiiiiiiieeee et 87

F o [TV A Y N AT [ 4= To 1= T R 23

AdJUSE TIFF IMAQgES......uuiiiiiiiiiiiiiiiiiiiieiiete et 87

Adjusting (JPEG or TIFF Image)
Automatic Adjustment (Tone Curve AsSIist).......ccccceeeevinnninnnnnns 88
BrightnNess .eee i 89
Click White BalanCe ..........coccuiiiiiiie e 90
(070] 01 (= 1] SR PP 89
DynamiC RANGE ........ooviiiiiii e 93
HUGB e 91
RGB Tool Palette ......ovvveeiieeiieiieeeeeeeeeeeeeeeeee e 111
SAtUrAtION ... 91
SNAIPNESS .o 91
Tone Curve AdJuStMENt........coooiiiiiiiiiiiiie e 92

Adjusting (RAW image)
APPlY AdJUSTMENTS.....coeeeie s 81
Automatic Adjustment (Tone Curve AsSIist)........ccccceeeeicciinnnnnns 30
BrightnNess ......ooiiiiii 24
Brightness of Highlights.............oooii 54
Brightness of Shadows.............ciiiiiiiii 54
Click White BalancCe ..............uuviiiiiiiiiiiiiiiiiiiiiieeeeeeeeeeeeee e 26
Color SAturation ..o 27
(070 ] (ool =10 0] 01=T £ 1 (0 [T 53
(7o) (o] Sl o) o 1= TSP 27
Color WHEE L. 53
CONrast.. ... 27
Copy AdJUSTMENTS ....oeeiiiieiiiie e 81
DynamiCc Range.........uuuiiiiiiieeeeee e 54
Filter Effect ... 28
MONOCAIOME ... 28
Personal White BalancCe ... 82
Picture Style ... 24
Picture Style File ........ooooiiii e 56
RAW Tool Palette..........uueieeiiieieieeeeeeeeeeeeee e 111
Save AdJUSIMENTS ........uuuiiiiiiiiiiiiiiiiiiii e 81
SNAIPNESS ... 29
Tone Curve Adjustment.........ooooiiiiiiiii e 55
ToniNG EffeCt ... 28

Tool Palette ..o 111, 112
White BalanCe ... 25
Adjustment Contents (ReCIiPe).......cccouviuiriiiiiiiiiiiiieieeee e 80, 122
AdODE RGB ... 123
APPIE RGBi....ii e 123
L =T gTo =T [ F=To [ 18, 19
Auto Lighting Optimizer .........covviiiiiii e 58
Automatic Adjustment (Tone Curve ASSISt).........cccceieeeeeeiiiiinneee. 30, 88
Automatic Dust Erasure Processing........ccccccceeeeiiieeenieennns 64, 65, 98, 99
B
Batch Apply White Balance to Images (Personal White Balance)....... 82
Batch Change the File Name of Images..........cccvvvveveieeiiiiiiieeieeeeeeeee, 85
Batch Convert/Save Images (Batch Process) ..........ccccvvveeveiiiiiiiiinnen. 83
Batch Process (Batch Save JPEG and TIFF Images)................. 83, 120
Batch Process of Multiple Images
Change File Name ............uuviiiiiiiiiiiiiiiiiiiiiieseeee e 85
Convert/Save (Batch Process)........cuuevveevevevveeeeeeeeeeeeeeeeeeeee, 83, 120
Personal White Balance...........cccccoo 82
RecCipe Data .....cooovvviiiiiii 80
TrANSTOr .. ——————— 84
Batch Settings WIindow..........cccooioiiiiiiiiiiis 83, 84, 120
Batch Transfer Images .........oooooiiiiiiiie e 84
Batch Transfer Images to Image Editing Software ...............cccoonnn. 84
Before/After Comparison Display ..............eevvvvviiiiiiiiieiieiiieeeeeeeeeeeeeeeeee, 50
DIt NUMDET ... e e eeeeees 122
= ToTo] {g £ F= T3 48
Brightness......coooiiiii i 24, 89
C
Change File Name............oooooiiiiiiii s 85
Changing the File Name of Images in the Order in the Main Window. 85
(0 a1=To Q1Y = T ST 17, 18, 109, 114
Chromatic Aberration Correction ...........ccoooocuiiiiiiie i 62
Chrominance Noise Reduction (JPEG, TIFF Images)...........cccccuuueeee. 94
Chrominance Noise Reduction (RAW Images) .......ccccccceevnurrnnnnnnnnnns 59
Click White BalanCe...........oouuiiieeiiieeeeee e 26, 90
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CMYK SImUIAtioN.......ooieeieii e 77,78, 123
Collection WINAOW ......cooueuiiiiiiiee e 6, 33, 108
Color Blur Correction .........ocooeeiiieieeeee 62
(©70] o] gl @1 o F- T S REPRR 123
Color Management (Color Matching).........coooecvviieiiieeiiniiiieeeeee e 122
Color Setting of the Monitor (Profiles) .........coevveeeviieiieiiiiiiieiiieeee, 77
Color Setting of the Printer (Profiles)......ccccccvvviviienil. 77,78
COlOr SPACE.......uuuuiuieiiiiiiitiittiitiatitrr bt ere e es s eeeeereeeeeeeeeees 123
ICC Profil€S v 122
Color Management (Preferences).........ccccciiiiiiiiiiiiiiiiiieeeeee s 77
Color SAtUratioN .....cceee i 27
Color Setting of the Monitor (Profiles)...........ccccveviiiiiiiiee 77
Color Setting of the Printer (Profiles) ............ccccccc, 77,78
COolOr SPACE ....cceeeeeeeeeeee e, 123
AdODE RGB ... 123
APPIE RGB ... 123
Color Space Setting for Each Image ..........cccccooviiiiiiiiiiiiiiiine, 68
(070] [o]4 1Y/ F=1 (1 I = €1 = S 123
Default Setting of Color Space ...........ccuveeveiiiiiiiiie e, 77
SRGB ... .. 123
Wide Gamut RGB..........coviiiiiee e 123
Color Space Setting for Each Image.....................ccoco, 68
Color Temperature...........coovviee e, 53
(©70] (o] gl 1o o 1= 20O RPN 27
COlOr WHREEI ... 53
ColorMatch RGB ..o 123
Compatible Cameras with the Lens Aberration Correction Function.. 60
Compatible Lenses with the Lens Aberration Correction Function..... 60
Contact Sheet Printing (Printing a Thumbnail List)............ccccccoonnnne. 70
[070] 011 =11 SFUUTT TR 27, 89
Convert to JPEG or TIFF Image and Save................... 39, 83, 116, 120
Convert/save One Image Window ................cccceeei, 39, 116
Copy Stamp (Image Correction) ..........ccccevviiiiiieenie i 68, 102
Copy Stamp Window ...............cc 64, 66, 98, 100, 119
Copying and Pasting (Applying) ReCipes..........ccccceeiiiiiiiiiiiieeeeieis 81
Correct Images (Copy Stamp Function) ..............c.cceeeeii. 68, 102

Introduction
Creating @ Folder........ooo i 47
D
Default Noise Reduction Settings...........cccuvvviiiiiiiiiiiiiieeeieeeeeeeeeeeeeeeee 76 Contents at
Default Setting of COlOr SPACE .......c.cveveiveeeeeeeeieeeeeeee e 77 a Glance
Delete IMAgES .....vvuiiii e 46
Deleting Basic
DElEte IMAGES ......oveeeeeeeeeee et ere e 46 Operation
Delete the Software ...........c..oovviiiiiii e 106
Deleting DPP (Uninstalling) ........cuuvmiiieiiiieeeeeeeeeee e 106
Dgtalled Setting Printing (Printing with Shooting Information)............. 69 gg‘é?:t?gg
Display
Before/After Comparison Display..........cccccoviiiiiiiiiiiiiiiiiieeeee, 50
Enlarged Display (Edit Window) ..................cl 11, 110 Advanced
Enlarged Display (Quick Check Window) ...........c.ccccvueunnn... 16, 114  |Image Editing
Shooting Information Display ............cccoviiiiiiiiiiiiiiieeeeeen 10, 21 and Printing
Single Image Display ... 20
Synchronize Edit WINAOW ..........ccoovoveveueeeeeeeeeereeeeeeeee e, 51 L;r%c§3§:ggrs
Thumbna!l D!splay (Main Wlndow).: ...................................... 10, 107 ogf Images
Thumbnail Display and Enlarged Display
(Edit Image WindOW)........ccccuiiiiiieeeeecieeee e 31,115 ”
DT (o) i{e] g IO 0] 4 (=Tox1T0] o 62 JPEEdg/I%gFF
Downloading an Image to Your COMPULEr ............evvvvivivveiiieeieeeeeeeeeeeee, 7 Images
Downloading Images from a Camera ...........ccccceeeeiiiiniiiiiiieeec e 7
Downloading Images from a Card Reader............cccccooiiiiiieenennnnn, 9
Downloading IMagEs ........cueeeeiiiiiieeiiiiie e 7 Reference
Downloading Images from a Camera............cccccuvvvvviinviiveeireeeeeeeeeeeeeeeee.
Downloading Images from a Card Reader ...........ccoociiieeeieiiiiiiiiieeenn.
Dust Delete Data ..........cooooieiiiiie e
Dust Erasure Processing
Automatic Dust Erasure Processing ..........ccccceevvvvviiiiieeeeennnns
Image Correction (Copy Stamp Function) ..........cccccccovnnnen. 68, 102
Manual Dust Erasure (Repair Function) ...........ccccccceeeiiniins 66, 100 @ @
DynamiC RANGe ........c.uuiiiiiiiii e 54, 93
E O
Edit Image WINdOW...........ccoiiiiiiiiiiiiiiieiiiiiiieeeeeee e 31,115
Edit WINAOW.......oooiiiieeeee et 11, 110
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EdItiNg ..o —Adjusting
Enlarged Display (Edit Window) ........cccooiiiiiiiiiiiics 11, 110
Enlarged Display (Quick Check Window) ...........ccccoviiiiiiiiiiieiiiinens 114
EOS Ui 7
F
False Color RedUcCtion ...........oieuiiiieeeee e 73,74
Filter EffeCt... .. e 28
FOIder WINAOW ........ieeeeee et 6, 107
G
General Settings (Preferences) .......ccvveevveeiiiiiciiie e 73
H
HelD o —————————— Cover
Highlight Area Warning Indicator ... 52
HUB e 91
|
ICC ProOfilES ... e 122
Image Frame Information (Image Marks) .........ccccevveeviiiiieiiieeiennnenn.. 109
Image Marks (Image Frame Information) ..........ccooccoiiiiiiiiiiniiiinnn. 109
Image Quality
Default Noise Reduction Settings...........cceevviiiiiiiiii 76
False Color RedUction ..........ooeeivieoeiiee e 73,74
Improve the Quality of an Image (Main Window) ...........ccccceeeeee... 21

Noise Reduction of a JPEG Image (Luminance, Chrominance) .. 94
Noise Reduction of a RAW Image (Luminance, Chrominance) ... 59

View and Save a RAW Image ..........cccoo oo, 73,74
Image Shooting Information Display ... 10, 21
Improve the Quality of an Image (Main Window).........ccccceeviiuveeennenn. 21
J
JPEG IMaQge.. .t 122
L
Lens Aberration Correction ..............oooviiiiiiiiiiiiieceee e, 60
Lens Aberration Correction Window ...........cccceeveeeeiiiiiiiiieeeeeeene 62, 118
LN BA ... e 27
Loading and Pasting (Applying) ReCIPesS ........cccccecuuurrurienniniiiiiiinninnns 81

Luminance Noise Reduction (JPEG, TIFF Images) ........cccccccvvnnnnnn. 94
Luminance Noise Reduction (RAW IMages) .......ccoevvviieeeeeeeeiniiiineee. 59
M
Main WINAOW ... e 10, 107
Manual Dust Erasure (Repair Function)...........ceeeveieeieieeieieeenneen. 66, 100
MONOCHIOMIE..... ..o e e e e e eeees 28
1] (= g = (Y o1 28
ToniNG EffeCt ... 28
MoVve Or COPY FOIErS ......coooiiiiiiiiiiiie e 48
Move Or COPY IMAGES ......uuuuuiiiiiiiiiiiiiiiiitiirr e e e e e e e eeeeees 47
N
Noise Reduction (JPEG or TIFF Image)........ccccvvvveeiviviieiieeiieeeeeeeeeeee 94
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About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademark Acknowledgments

Macintosh is a trademark of Apple Inc., registered in the United States
and other countries.

Adobe and Photoshop are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other
countries.

Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.
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